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Introduction to Impact/SQL Accounting 

This manual explains all of the functionality contained within the Impact Accounting module 
(Accounting), and discusses how each tool might be used.  As each company functions in its own 
unique way, there are some functions that may not be utilized, but you are encouraged to 
examine and consider all of them, to ensure you are getting the most out of Impact. 
 
Accounting provides the escrow accounting department with the tools required to oversee the 
integrity of the financial activity initiated by escrow personnel, and to manage bank-related tasks, 
such as wire transfers, positive pay processing and bank account reconciliations, and system 
maintenance procedures for the entire operation.  While the division of responsibilities within any 
client site will vary one from another, the functions grouped within Accounting tend to be 
performed by most escrow accounting departments or affiliated administrative units.  Escrow 
personnel generally do not perform these functions – their tools are contained in the Impact 
Escrow module (Escrow). 
 
There are functions that accounting personnel perform, on a daily basis (generally in the early 
morning), to review and “post” the activity of the previous day, in effect finalizing the transactions 
developed by Escrow and Accounting.  There are activities in which accounting personnel 
participate, in conjunction with escrow personnel, throughout the workday, such as wire transfer 
processing and receipt and disbursement correction.  Accounting personnel also perform 
functions that help ensure that the activity within the system is accurate and reconciled with 
activity reflected in the escrow trust accounts at the company’s bank(s).  There are also 
maintenance tasks that accounting personnel are responsible for, such as setting up new branch 
or bank information in the system, or changing the branch or officer assignments on escrow files.  
Regulatory reporting (1099-S) is also managed through Accounting. 
 
This manual progresses through the functions in Accounting in the order that they appear on the 
menus within the module.  This will not be how you will work with the product, as that will depend 
on your responsibilities and the structure of each individual business, as well as the configuration 
of Impact at each business. 
 
There are a tremendous number of configuration options that can affect the functionality of the 
system.  These variations are discussed in this manual, to the extent that the discussion does not 
detract from the explanation of the functions of the complete package. 
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General Information and Helpful Hints 

This manual progresses through the functions in Impact Accounting in the order that they appear 
on the menus within the module.  This is not how you will work with the product, as that will 
depend on your responsibilities and the structure of each individual business, as well as the 
configuration of Impact at each business.  Before discussing the system functionality in detail, 
there are some general features that you should be aware of.  These are discussed below. 
 
Some formatting conventions used in this manual are: 

• When you need to press the Enter key, you will see ENTER in this manual. 
• When you see text displayed on a menu or window such as the words “Edit” or 

“Cancel”, you will see Edit  or Cancel  in this manual. 
• Daily Work > Positive Pay  means that you select Daily Work from the main 

menu and then select Positive Pay from the sub menu. 

Helpful Hints for Entering Information 

Dates 

Do not enter hyphens or slashes when entering dates into Impact. 
 
Enter dates as 2 digit month, 2 digit day, and 2 digit year, for example, “122504” for December 
25, 2004.  If entering a different century other than the current century, you must enter a 4 digit 
year.  You can also click on the box with “…“ just to the right of the date entry area, or use the 
CTRL+D Quick Keys, to pull up the Calendar  tool. 
 
 
 

 
 

Dollars 

Do not put commas or dollar signs in the dollar amounts. 

F4 

You may use the function key F4 to access a drop down list box, or you may click with the mouse 
on the down arrow. 

TAB 

Use TAB  to move forward from one entry field to the next entry field. 
  
Use SHIFT+TAB  to move backward from one entry field to the previous entry field. 

For the Calendar tool, click on this 
box or use the CTRL+D Quick Keys 

Date entry area 
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Execute 

When you see a button with dots on the face, you can press ENTER to execute that command, 
rather than clicking on it with the mouse, as the button already has “the focus”.  Press TAB  to 
move the focus to the other button(s). 
 
 
 
 

 
 

Quick Keys 

Quick Keys can quickly accomplish tasks by using keyboard entries instead of using the mouse to 
click on selections.  Quick Keys are one or more keys you press on the keyboard to complete a 
task. 
 
For example, press and hold the ALT  key and also the F key.  This ALT+F  key combination 
opens the File  menu, just as clicking on the File  menu at the top left of the Impact Accounting 
screen opens the File  menu. 
 
Anytime you see a menu selection item on the screen that has a letter in the word underlined, you 
can use the Quick Keys alternative to using the mouse, for example, use the ALT+C Quick Keys 
to drop down the Recon  menu because the “C” in Recon  is underlined. 
 
 
 

 
 

Press ENTER to execute “Next” 

ALT+D opens the Disbursements 

ALT+O opens the Daily Work menu 
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Logon 

Access to the Impact Accounting module (as to all Impact modules), is controlled by a user-rights 
table, administered by a limited set of user ID’s that have sufficient authority granted to them.  
This is a very important control, and should be carefully managed.  Depending on the nature of 
the rights assigned to a user, they will have access to various pieces of the overall Impact suite, 
but generally not complete access.  This functionality helps reinforce audit controls, and needs to 
be considered in conjunction with the network security plan. 
 
The system can be configured to require a logon routine, each time the user opens an Impact 
module, or it can be configured to provide for an automatic logon utilizing the NT user name.  By 
providing for an automatic logon utilizing the NT user name, control over the access to the 
application is very flexible: both the system administrator and the rights table within Impact can 
control access.  The system administrator can control access by disabling the user’s NT user 
name, a likely event in the case of an employee’s departure. In addition, the user name can be 
disabled within Impact Utilities – which will only affect the user’s ability to access Impact modules.  
This would be done if the user is still using the rest of the network, but should no longer be 
accessing Impact. 
 
There is not an automatic expiration of passwords setting within Impact, so to ensure strong 
controls the administrator would have to routinely change all users’ passwords, and inform the 
users of them, if the automatic logon based on NT user names is disabled.  For this reason, the 
use of an automatic logon based on NT user names can be a more effective control – assuming 
automatic expiration of passwords is implemented through the NT operating system.  This matter 
is more fully explained in the Impact Utilities manual. 
 
If the system is configured to require a user to logon to Impact Accounting, a screen like that 
shown below will be presented, after the user double-clicks on the Impact Accounting icon on 
their desktop. 
 

 
 
 
 
When configured to require a logon step, the user will be identified within the system by their 
initials (3 maximum), and will be given a password. 
 

Drop down list arrow 
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Enter your user initials in the first field, and then TAB  to the Password  field. Enter your password 
and, if the correct database is identified in the Log on to  field, click OK. If the database is not 
correct, then TAB  to the Log on to  field and select the correct database by clicking on the drop 
down list arrow and highlighting a database name; then click OK. Most users will only have one 
database available. 
 
Alternatively, if you do not want to use the mouse to click OK, you can hit the TAB  key until OK is 
highlighted, and hit ENTER. 
 

NOTE: When you enter your password, it will not display on the screen, but will be 
represented by a series of asterisks “*”. 

 
If you don’t want to continue, click on Cancel  instead. This will cause the Logon dialogue box to 
close and the Impact Accounting module will not be opened. 
 
KEEP YOUR PASSWORD PRIVATE.  You should not share your password or log on to the 
system and then let someone else operate under that session. The initials of the user logged on 
to the system will attach to transactions entered, and you will only want to be responsible for your 
own activity. 
 
If you forget your password, the administrator of the Impact application must assign a new one. 
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The Impact/SQL Accounting Desktop 

Impact Accounting Desktop 

Impact will display a desktop as shown below when you sign into the Accounting module. 
 
The screen, as it initially opens, presents the user with a menu of options across the top of the 
screen.  Each option has a dropdown menu below it, which will be displayed when you click on 
the option name.  Once you have clicked on one option name, and the menu list below it is 
presented, you can slide your cursor down the list, with your mouse, to get to the function you 
wish to use.  If you are not sure under which option heading the desired function is housed, click 
on any option heading and, once the menu list is presented, slide your mouse to the left or right, 
to other option headings, and their menu lists will present without you having to click again, and 
you can then browse all of the menu choices available to you. 
 
 
 
 
 

 
 
 
 
 
The current date should be displayed in the lower right corner of the Impact desktop. If you do not 
have the current date displayed, notify your system administrator and do NOT continue to enter 
activity to the system–having the correct dates on activity is very important. The current date is 
used for the open date of a title only file, the typed date of the Prelim/Commitment, the print date 
on documents, the receipt date, check date, and voiding of check date. 

File > Exit 

You should Exit  out of Impact when you are leaving your desk for an extended period, or are 
going home for the day. Always Exit  out of Impact at the end of each day, before logging off of 
your computer. If you leave your Impact Accounting session logged on, others will have access to 
your “rights”, and this could raise security concerns. 

Impact Accounting desktop may 
show your company logo 

Logged in user’s name 
 

Current date 
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Daily Work Menu 

The Daily W ork  menu option can have up to six items under it, depending upon the settings 
made in Utilities: 
 
 Deposit Slips (conditional) 
 Positive Pay (conditional) 
 Reverse Positive Pay (conditional) 
 Unposted Batch Listing 
 Post Receipts and Disbursements 
 Audit Accounting Data 
 
Each of these items is very distinct from the other, and will be explained in detail below. The 
items do not  ‘flow’ one to the next, as in a process workflow order. These tend to be once-a-day 
functions, as opposed to tasks that are executed repeatedly throughout the day. 

Deposit Slips 

The use of deposit slips is a system configuration option. They do not need to be used. If they are 
not used, all receipts will present in the reconciliations directly. If they are used, only depositable 
receipts tagged to a deposit slip will appear in the reconciliations; along with the non-depositable 
receipts. For this reason, it is strongly recommended that the use of deposit slips be 
initiated at startup of the use of Impact or  only at the start of a new month—never  mid-
month.  If their use is started at a date later than the initial startup of use of Impact, the person 
preparing the reconciliation will need to take a special step to get the “pre-deposit-slip receipts” to 
appear in the reconciliation for the period prior to use of deposit slips (to be explained in the 
reconciliation documentation). 
 
Receipts, in Impact, are either “depositable” – meaning they represent items that would be put on 
a deposit slip and taken physically to the bank; or “non-depositable” – meaning they represent 
items that appear on the bank statement as a result of electronic transfers or wire transfers, or 
items which will never appear on the bank statement, such as correcting adjustments. The 
“receipt types” are maintained by the Impact Administrator (through the Utilities module), and 
should not  be altered once put into use. New receipt types may be added, and when they are, 
their “depositability” is determined. When a receipt is prepared, the receipt type is selected. 
 
Receipts that are depositable must  be attached to a deposit slip before they will appear in the 
reconciliation for the trust account identified on the receipt.  Non-depositable receipts will appear 
directly in the reconciliation of the trust account identified, such as wires.  
 
The ability to prepare deposit slips through the Accounting module is set in Impact Utilities.  It is 
up to the company to determine, based on its structure, whether deposit slips will be prepared by 
Accounting personnel, Escrow personnel or both.  For the purposes of this documentation, we will 
assume that the function is accessible in Impact Accounting. 
 
 When the Deposit Slip  option is selected, the user will be presented with the following screen: 
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Print & Select All 

The primary function of this screen is to provide for the “tagging” of receipts to a deposit slip.  In 
most environments, Escrow personnel will be responsible for preparing deposits.  However, there 
may be times when Accounting needs to prepare a deposit slip.  The business should make sure 
everyone with access to the deposit slip function is aware who will be primarily responsible for 
creating deposit slips, and those that are not primarily responsible should only prepare a deposit 
slip under very specific situations.  For example, Accounting might prepare a deposit slip 
comprised solely of depositable items that it has in its possession (funding checks, for instance, 
that came to the Home Office, rather than to a branch). 
 
When first opened, this screen will have the current system date in the Items for: (date) and 
prior  that are undeposited  field.  To limit the listing to an earlier cutoff date, the user should 
enter the desired cutoff date.   
 
All  will be entered, by default, in the Branch  field, but the user can limit the item list by selecting 
an individual branch from the dropdown list.   
 
Finally, the Bank  field will be blank, if there is more than one bank defined in the system, and the 
user should select the appropriate bank from the dropdown list.  Once the bank is selected, and 
the user hits TAB , a listing of the undeposited receipts, created on or before the cutoff date, for all 
branches or a single office if selected, for the bank identified, will be presented. 
 
To prepare a deposit slip, the user will click on the box in front of one or more receipts, under the 
Deposit  column, and, once all the items that are to be included in the deposit are checked “�”, 
the Print  box should be clicked.  If all receipts are to be included in one deposit slip, click on the 
Select  All  box, before clicking on the Print  box. 
 
When the Print  button is clicked, the screen will change to 
include an information box about the deposit slip being 
prepared, as is shown here:   
 
Check to be sure that the count of the physical items to be 
deposited matches the count shown on the screen, and that 
the deposit total matches the sum of the physical items.  If all 
is in order, click on OK, and the deposit slip will print, on the 
check printer, if there is one assigned (and the routing 
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information will be on the deposit slip, in MICR toner), and you will be returned to the previous 
screen.  Note that the deposit slip number will not be assigned, until the deposit slip is printed.  If 
there is a problem with the count or total figure for the deposit, click Cancel , and you will be 
returned to the previous screen, without a deposit slip having been prepared. 
 
The items that had been selected for the new deposit slip will no longer be listed, after a deposit 
slip is printed. 

Add 

The ability to Add  a manual deposit to the system is restricted to Accounting only.  This 
functionality would be used in very rare situations, when a bank deposit item is anticipated that 
will not be reflected in the routine receipts entered through the system.  For example, if an initial 
deposit were made to open the escrow account, and you wanted to have the item reflected in the 
reconciliation as a deposit, rather than a reconciliation adjustment, you could add a manual 
deposit. 
 
To add a depositable item, click on the Add  button, and provide the bank, date and amount for 
the deposit to be created and click OK.  Cancel  if you entered this area in error. 

Void 

The system can be configured to allow Escrow personnel to Void  a deposit slip, but it is generally 
a function limited to Accounting. 
 
When a deposit slip is voided, the receipts that were assigned to the deposit will be made 
available to be assigned to another deposit.  Care should be taken to not void a deposit that has 
already been pulled into an active reconciliation.  A deposit slip that has cleared the bank, as 
identified through a completed reconciliation, cannot be voided. 
 
Generally, a deposit slip would be voided, by Accounting, at the request of Escrow, when items 
have been included in a deposit slip, which should not have been, and Escrow would like to re-
build their deposit with the correct items.   
 
To void a deposit slip, click on Void , and you will be prompted for the deposit slip number of the 
deposit you wish to void.  A search function is included to help you locate the deposit slip number.  
Enter the number and you will then be prompted to confirm that you wish to void the deposit slip. 

RePrint 

A copy of a previously generated deposit slip can be generated, with the RePrint  button.  You will 
be prompted for date, bank and number of the deposit slip to be reprinted.  A search function is 
included to help you locate the deposit slip. 

Sort 

You may sort the listing of the items ready for a deposit 
ticket. This sort may be your permanent display. You have 6 
available fields for sorting: the internal bank number Impact 
assigns to the bank, the escrow number on the receipt, the 
receipt number, the ABA number entered on the individual 
receipt, the amount received and the deposit type applied to 
the receipt. Highlight an available field and click on Add  to 
start your sort hierarchy, or you may click on Defaults  and 
Impact will sort the items by receipt date then branch 
number. Click on OK to activate your sort. 
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Positive Pay & Reverse Positive Pay – General Discussion 

Title and escrow companies face a great risk of people trying to run fraudulent checks through 
their trust accounts, primarily as these accounts tend to maintain large balances, and the account 
numbers are well known, due to the volume of checks issued by such companies.  The “positive 
pay” concept was developed to identify checks hitting an account that do not match, across check 
number and amount, items known to have been issued by the owner of the account.  While this 
process will do nothing to catch theft from within a company (through the issuance of a legitimate 
check to an illegitimate recipient), it is very successful against outside attempts to siphon funds 
out of an account. 
 
Two different approaches to “positive pay” processing exist: positive pay and reverse positive 
pay.  Under the first approach, the bank customer provides a listing of all checks issued to the 
bank, and the bank matches that list up against items presented for payment.  If there is a 
discrepancy between the check number and amount, between the customer’s list and what the 
bank’s proof operation has identified, an exception is generated.  The list of exceptions is 
presented to the customer, for a “pay” or “do not pay” decision, item by item.  Generally, the 
exception report is received in the morning, regarding items presented the prior day at the bank, 
and a response is required within a few hours.   
 
Reverse positive pay puts the matching task in the customer’s hands.  The bank will provide a list 
of all items presented for payment the previous day, and the customer must review the list and 
identify exceptions that should not be paid, by comparing the bank list against data in the 
customer’s system about checks previously issued and not yet cleared or voided.  The customer 
then notifies the bank, within a time window, of which items should not be paid. 
 
Both of these approaches can be accommodated in Impact Accounting.  The system can be 
configured to provide either or both functions to the user.  Alternatively, both can be disabled.   
 
Both versions of positive pay processing rely on “bank filters”.  The filters used in the positive pay 
export module, arrange Impact data on checks issued into a layout that the bank can read.  Just 
as there are many banks, there are many different layouts that they utilize – they have not all 
accepted a standardized layout.  DSI has developed filters for many banks, and they are 
available within Impact Accounting’s positive pay function. 
 
The filters used in the reverse positive pay module rearrange the data provided by the bank into a 
layout that Impact Accounting can utilize, in matching up against the open check file.  There are 
not as many banks using reverse positive pay, and so there has been less demand for different 
filters.  Therefore, there are fewer filters available within Impact Accounting for reverse positive 
pay. 
 
The client must discuss which services are available with their bank(s), get a sample of the record 
layout the bank(s) require or provide, and then determine, in consultation with DSI, whether the 
required filter(s) is available within Impact, or must be created by DSI.  At that point the 
appropriate service should be utilized. 

Positive Pay 

If Positive Pay has been enabled, the Accounting user will, on a daily basis, use the function to 
prepare a file(s) to be uploaded to the bank(s) involved.  The upload method will depend on the 
bank involved.  Some banks provide for a Web-based file transfer system, some require a direct 
dial-up link and an FTP upload, and some will have you e-mail the file(s) to them. 
 
The screen presented, when Positive Pay is initiated, is displayed below.  The following steps 
should be followed to prepare the export file. 
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1. The bank account to use is selected first.  Use the dropdown list to pick your account.  Note: you 
will need to run this routine for each account whose bank is expecting a positive pay file. 

2. The date range for checks to be exported is then identified – enter each date in “mmddyy” format.  
Be sure to include weekend and holiday dates, when appropriate.   

3. The directory where the export file will be placed is identified in the window below the date range, 
and the file name for the exported file is selected in the window to the left.  Once these have been 
identified, they will be retained for each account. 

4. The last, critical selection is in the lower left corner: Export Filter.  Be sure the correct filter is 
selected, or the bank will not be able to read the file prepared. 

5. Click OK to generate the file in the location specified. 

6. Repeat for all accounts, as required. 

7. Cancel  and then, outside of Impact, send the file(s) to the bank(s), in the manner identified by the 
bank(s). 

 

 
NOTE: The Batch Processor can be set to generate positive pay files at night.  Multiple accounts 
for one bank will be appended to a single export file.  In “Accounting” one file is created for each 
account as it is processed. 

Reverse Positive Pay 

The reverse positive pay function requires that the file(s) provided by the bank(s) be in place 
before the function is initiated. 
 
The screen looks very much like the positive pay screen displayed above, without the date 
selection range.  The steps to be taken to perform a reverse positive pay cycle are as follows: 
 
1. Download the data file(s) from the bank(s) and save it on the local machine or on a mapped 

network drive. 

2. Go into Impact Accounting> Daily Work> Reverse Positive Pay . 

3. The bank account to use is selected first.  Use the dropdown list to pick your account.  Note: 
you will need to run this routine for each account for which a file was downloaded. 

4. The directory where the file to be imported is located is identified in the window on the right, 
and the file name for the import file is selected in the window to the left.  Once these have 
been identified, they will be retained for each account. 
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5. The last, critical selection is in the lower left corner: Import Filter.  Be sure the correct filter is 
selected, or Impact will not be able to read the file(s) provided by the bank(s). 

6. OK to import the bank data and compare it with the checks in Impact. 

1. An exception report will be generated of bank items not located or bank items with 
amounts that differ from the amounts in Impact.  Review the report, determine whether 
the items are legitimate and communicate your findings to the bank. 

2. Repeat for all accounts, as required. 

Posting – General Discussion 

Impact does not instantly “post” each financial entry created by Escrow in real time.  The receipts 
and disbursements are held “in process”, until such time as they are accepted, or “posted” by 
Accounting.  This permits Accounting to review the items before they are made part of the 
permanent record.  Accounting can make corrections to items prior to their being posted.  For 
example, someone in a branch may create a receipt for $1,000.00, instead of for $100.00, and 
not notice it until the next day (when they cannot correct it).  They can notify Accounting, which (if 
posting has not been done yet) can correct the receipt. 
 
The receipts and disbursements are held in “batches”.  A batch is comprised of records with a 
unique combination of a date, a bank, a branch and a type (receipts or disbursements).  These 
batches build throughout the day, as transactions are created, and at the start of a new calendar 
day, new batches are created as work (receipts and/or disbursements) is generated.  Weekend 
days are each uniquely tracked just as weekdays are.  Therefore, at most, there will be two 
batches for each bank/branch combination for any one day.  Should there not be any receipts 
and/or disbursements for a bank/branch on any one day, there may be only one batch or no 
batch at all, for that date. All batches for one calendar day are posted together (see Daily Work> 
Post Receipts and Disbursements ). 
 
To cut down on reconciliation adjustments, and to catch errors in receipts when they can still be 
fixed, it is recommended that receipts and deposits be reviewed for correctness and 
completeness prior to posting.  In a working environment where field offices prepare deposits, 
and send copies of the deposits to Accounting, the unposted batch listings for receipts can be 
used to check that the amounts and items contained in the branches’ deposits are correct and all 
inclusive.  If this is being done, it is most helpful to instruct the branches to only include receipts 
of one day on any deposit slips.  If the branches mix receipts of more than one day on a deposit 
slip, it makes reviewing of the deposits, versus the unposted batch listings,  more difficult. Footing 
the physical items separately from a footing of the deposit slip, and footing the unposted 
depositable receipts for the bank/branch for the day, will give you a three-way confirmation that 
the deposit was properly prepared. 

Unposted Batch Listing 

Accounting can, at a quick glance, determine if any accounting work was done for a particular 
bank/branch combination, for any unposted day, by going into Daily Work> Unposted Batch  
Listing .  Each escrow branch may have one receipt batch and one disbursement batch per bank 
on any day, depending on the banking activity for that date. The listing presented there can be 
previewed and/or printed.  Such listings should be reviewed prior to moving files from branch to 
branch, to ensure that there are no unposted items that might be affected by a move.   
 
In the display below we see branch 998 on 09/06/2005 has a receipt batch only.  This means no 
checks were disbursed for that branch and bank on 09/06/2005. 
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To learn how to print the detail of an unposted batch, see the Receipts> Print Daily Receipts  
Journal  and Disbursements> Print Daily Disbursements Journal  discussions, later in this 
manual. 

Post Receipts And Disbursements 

The “posting” of accounting transactions makes them part of the permanent record within the 
escrow ledgers.  Posting is done for one day at a time, and the system processes items in file 
order, with items posted in chronological order of their creation.   
 
Prior to posting, and prior to Closing a month, the audit of accounting data function should be run 
(see Daily Work> Audit Accounting Data , below). 
 
The commencement of a posting cycle results in the setting of an internal flag that notifies the 
system that a posting is in process, and causes the generation of several reports.  These reports 
are critical, and should be retained.  They are invaluable in researching problems that might arise 
down the road.  Specifically, a Posting Analysis, Receipts Journal, Disbursements Journal and an 
Income Journal for each bank/branch are generated. 
 
NOTE: Be sure to have the reports generated through the posting cycle in hand (make sure they 
came out of the printer) before you finalize the posting.  Not all of the reports can be regenerated 
after a posting is complete.  If there is a problem printing the reports, when the posting cycle 
starts, cancel the posting, resolve the printing problem, and then restart the posting. 
 
Care should be taken not to start a posting cycle for the current calendar day.  If a posting cycle is 
started for the current day, Escrow users will be prevented from entering financial transactions 
until the posting is complete.  In addition, another posting will need to be done, the following day, 
for the transactions entered after the posting was done. 
 
After the posting has been initiated, and the reports have been generated, one final review of all 
of the work should be made.  If all appears to be in order, the “go ahead” to complete the posting 
should be given.   
 
Once complete, items that had appeared on the “in process” tabs, when viewing a ledger, will 
have moved to the posted tab.   The Trial Balance report will reflect the posted items.  A 
reconciliation can be started for the period ending with the last date posted.  Income items (fee 
checks or fee slips) are made available to the Income Analysis system.  In short, the transactions 
are now part of the permanent record. 



Daily Work Menu 
─────────────────────────────────────────────────────── 

─────────────────────────────────────────────────────── 
USA Digital Solutions, Inc. 
Accounting v5.12.0 Manual Page 17 of 98 5/30/2007 

Audit Accounting Data 

The “audit” function can conduct a series of “tests” of the data within the system, to ensure that all 
running totals, branch and ledger balances, for example, are correct.  Normally, the audit is set to 
run at night, via the Batch Processor, and the resulting report will generate to the Accounting 
printer.   
 
This report should be examined carefully before posting each day.  In addition, the audit should 
be run prior to closing the month (see Month End> Close Month , below). 
 
A blank audit report is a GREAT audit report, and will be the normal result of running the audit.  A 
discussion of all of the possible audit errors and their resolution steps will not be presented here – 
as the scope can be quite far ranging.  As errors are identified, contact DSI’s Support for 
assistance, until you are familiar with each type of error and how to deal with it. 
 
While the audit is normally run automatically at night, via the Batch Processor, you can run it at 
any time, from Daily Work> Audit Accounting Data .  The following screen will be displayed.  
You can check any and all of the boxes on the left side.  Each will trigger a different “test” routine 
to be run.  The box shown on the right side of the screen will only be made available to users with 
“administrator” rights.  If you did not mean to run the audit, or when it is complete, press Cancel  
to close this screen; OK to run the selected audits. 
 

 
 
The “Escrow Master to Ledger (Quick)” option will add up all the receipts and disbursements for 
each ledger and compare the net figure with the ledger balance being carried on each file. 
 
The “Escrow Master to Ledger (Full)” option will do what the “Quick” option does, but it first 
computes the running totals through each transaction within each ledger.  This run will take much 
longer than the “Quick” option. 
 
The “Escrow Master to Branch/Bank” option adds up all of the ledger balances for each 
branch/bank combination and compares the totals to the branch/bank balances being carried 
forward. 
 
The “Escrow Master to Savings Master” option will compare the savings total being carried on 
each escrow file master to the total of saving accounts for each file. 
 
The “Savings Master to Ledger” option will compute the net savings transactions within each 
savings ledger and compare that with the total being carried on each savings ledger. 
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The “Savings to Branch” option will compute the total savings ledgers by branch and compare 
that figure to the total being carried in the system for each branch. 
 
The “Audit Deposits” option will confirm that the receipts within each deposit add up to the total 
being carried for each deposit. 
 
The options on the right side of the screen will allow selected users to have the system attempt 
“repairs” on errors discovered.  This should be used very selectively. 
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Receipts Menu 

 
The receipts menu contains functions related to creating, modifying, and printing receipts.  Also 
discussed are transferring funds and releasing holds.  Several of these functions are also 
available in the Escrow module. 
 
The Receipts  menu option has the following items: 

• Create & Modify 
• Receipt Correction 
• Transfer Funds 
• Release Held Receipts 
• Print Daily Receipts Journal 

 

Create & Modify Receipts 

When Create & Modify Receipts is selected from the Receipts  menu, the Receipt Entry  screen 
opens.   
 
From the Receipt Entry  screen, you can create, modify, and delete receipts, depending on 
system configuration. 
 
When the Print  option is active (not dimmed-out) at the top left of the screen, clicking on Print  
gives access to the Receipt , Print File , and Reprint Posted Receipt  functions. 
 
If the Bank  field is active (not dimmed-out), use the function key F4 for accessing the drop down 
list box, or you may click with the mouse on the down arrow.  Once the first receipt has been 
entered, you will not be able to change the bank, unless the file balance is zero. 
 
NOTE: A new file will have its bank set to the default bank for the branch of the file, if there is 
one, but the bank can be re-selected, if others are available, when the first receipt is done or 
when the file has a zero balance. 
 
Enter a name in the Payor Name  field.  The payor is the person who gave you the money, or the 
source of the money for which the receipt is being created.  The Payor Name will be the 
description shown on the escrow ledger.  If the Payor Name is left blank, then looking at a 
receipts journal or ledger, no description will appear. 
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If appropriate, type a different name in the Escrow Name  field, from that which is pre-filled.  After 
the seller and buyer names are entered into the escrow file, they will appear here. 
 
Select a Receipt Type  from the drop down list. Be sure to use the correct receipt type.  Only use 
a depositable receipt type when you have an item that will be physically deposited at the bank.  
Use the WIN- Wire In  receipt type if entering a receipt for a Wire In.  Depending on system 
configuration, if TRF- Transfer  from the Receipt Type  drop down list is selected, an alert box will 
pop up, use Receipts  > Transfer Funds instead.  You will receive this message only if the 
feature Transfer  Funds is turned on in the setup options, otherwise you will have the ability to 
use the receipt type of TRF. 

 
If the Receipt Correction/Transfer  feature is turned on in the setup options, Impact will display 
the following prompt. 
 

 
If you are recording a non-sufficient funds notice from the bank, the receipt type will be NSF.   
Impact will prompt you for the original receipt number for the item being returned by the bank. 
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If available, enter a number in the ABA Number  field. 
 
If you are entering a savings receipt (SAV- Savings  receipt type), select the appropriate savings 
account number in the Savings Acct # field, use the function key F4 for accessing the drop down 
list box, or you may click with the mouse on the down arrow.  Interest on a savings account is 
entered with a receipt type of INT.  Impact has accounting reports that will show the principal and 
interest earned as separate columns. 
 
The Hold  radio button allows placing a hold on the funds. Escrow may not disburse held funds 
until released by accounting personnel.  (See Receipts>Release Held Receipts  for 
documentation.) 
 
Click on OK to save the entries and open the Print Receipt  dialogue box, or click on Cancel  to 
return to the Impact desktop. 
 
To switch from the Entry  tab to the History  tab, click on the History tab with the mouse, or use 
the ALT+H  Quick Keys. 
 

History Tab 

The History  tab displays all receipts applied to the escrow. 

 
 
Highlight a receipt from the list and click on the Print  button to reprint an unposted receipt or a 
posted receipt. 

Modify A Receipt 

Accounting may modify a receipt prior to posting the daily work.  If the receipt is posted then a 
new adjusting receipt needs to be made.  See Receipts  > Create & Modify Receipts. 
 
From the Impact desktop select Receipts  > Create & Modify Receipts  to open the Receipt 
Entry  screen.  Do not enter an escrow number.  Click on Modify  and you will be taken to the 
following screen.  Enter your escrow number and click on Find .  Impact will list any unposted, 
receipts found for that escrow number.  Highlight the receipt you wish to modify, then click on the 
Modify  button. 
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You will be presented with the receipt screen where you may modify  or, depending on your 
system configuration, delete  the receipt. 

 

Print 

The Print  selection from Create & Modify Receipts  allows the user to reprint an in-process 
receipt, print an outstanding receipt batch file listing or reprint a posted receipt. 

Receipt 

The Create & Modify Receipts > Print > Receipt allows the user to reprint an unposted receipt.  
You will follow the same procedure as Modify a Receipt above. 

Print File  

The Create & Modify Receipts > Print > Print File  allows the user to produce a listing of all 
receipts in an unposted batch file.  You will follow the same procedure as Print Daily Receipts 
Journal  described below. 

Reprint Posted Receipt 

The Reprint Posted Receipt  allows a user to generate a reprint of a receipt created on a 
previous day which has been posted by accounting.  The Reprint Posted Receipt  will show the 
original receipt number and have a heading of “Posted Receipt”.   
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Receipts – Some Common Situations 

There are several common situations involving receipts.  Some of these are discussed below, 
with the steps that should be taken to correct an error situation or to complete a receipting 
process. 
 
A receipt was entered into the wrong file, but has not been deposited or posted, and 
deleting is not available. 
 
1. Receipts 
2. Create & Modify Receipts 
3. Modify  
4. Enter the file number and click on Find  
5. Highlight the receipt to be edited 
6. Modify  
7. Enter a zero, “0”, into the amount field 
8. Enter “Entered in wrong file” in the payor field 
9. OK 
10. Then create a new receipt in the proper file 
 
Note:  If the receipt has already been included in a deposit, the deposit will need to be voided 
before you can edit the amount, then the deposit will need to be rebuilt, with the new receipt. 
Note: If the receipt has already been posted, use two new receipts to detail the movement of 
funds from one file to another. 
 
A receipt was entered for the wrong amount, but has  not been deposited or posted. 
 
1. Receipts 
2. Create & Modify Receipts 
3. Modify  
4. Enter the file number and click on Find 
5. Highlight the receipt to be edited 
6. Modify  
7. Correct the amount of the receipt 
8. OK 
9. Print  the corrected receipt and provide the receipt to the branch involved 
10. Note:  If the receipt has already been included in a deposit, the deposit will need to be voided 

before you can edit the amount, then the deposit will need to be rebuilt, with the corrected 
receipt. 

 
A receipt was entered for the wrong amount, and has  been posted. 
 
1. Receipts 
2. Create & Modify Receipts 
3. Enter the escrow number 
4. Enter the details for an adjusting receipt (positive or negative as needed) 
5. Reference the original receipt number in the payor field 
6. OK 
7. Print  the adjusting receipt and provide the receipt to the branch involved. 

Savings Receipts – A Two Step Process 

Prior to doing any savings receipts, the savings account (interest bearing account) involved must 
be set up via Misc > Set Up & Print Savings Accounts > New Saving s Account . 
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To add funds to a savings account, the funds must first be receipted into the escrow normally.  
Then, two receipts need to be created: one to take the funds out of the normal escrow trust 
account (coded with the STF receipt type, and with a negative amount), and one to put the funds 
into the savings account (coded with the SAV receipt type, with the savings account identified, 
and with a positive amount). 
 
To withdraw funds from a savings account, the process is reversed.  Two receipts need to be 
created: one to take the funds out of the savings account (coded with the SAV receipt type, with 
the savings account identified, and with a negative amount), and one to put the funds into the 
escrow trust account (coded with the STF receipt type, and with a positive amount). 
 
The INT transaction records interest earned into the savings ledger. The INT transaction allows 
Impact to show the amount designated as interest versus the principal amount on the savings trial 
balance. 

Receipt Correction 

The Receipt Correction feature is a setting only applicable to companies that fall under the 
jurisdiction of the California Department of Corporations (DOC) – that is “escrow only” companies, 
in California.  The regulatory requirement is that if funds are receipted into an escrow file, and it is 
determined at a later date that the funds should have been entered into a different file, correcting 
receipts with the same receipt number on each are to be entered into the original file (with a 
negative amount) and into the correct file (with a positive amount).   
 
Receipt Correction automates the procedure by allowing the user to answer a few questions 
(original escrow number, receipt number, and new escrow number) and then the system will 
automatically generate the needed receipts per DOC regs. 
 
Enter the original escrow file number in the From Escrow Number field;  enter the original receipt 
number that corresponds with the original escrow file number.  Then enter the correct escrow file 
number.  Impact will generate two receipts, with a receipt type of  RCT, with the original receipt 
number, showing funds taken out of the original file number and being credited to the new file 
number. 
 

 
Impact will display a prompt asking for confirmation for a receipt correction.  Please click on the 
Yes button to proceed or the No button to abort the receipt correction. 
 



Receipts Menu 
─────────────────────────────────────────────────────── 

─────────────────────────────────────────────────────── 
USA Digital Solutions, Inc. 
Accounting v5.12.0 Manual Page 25 of 98 5/30/2007 

 
Impact will allow a receipt correction from one branch to another as long as both files are 
assigned to the same bank.  If the “from escrow number ” and the “to escrow number ” are in 
different bank accounts, Impact will display a prompt that the files are not assigned to the same 
bank and not let you do a receipt correction.  You must then do a separate negative receipt out of 
the original file and a positive receipt into the correct file.  If the funds were deposited in the bank 
you will have to transfer funds from the incorrect bank to the proper bank. 
 
The receipt correction will not allow you to overdr aft the originating file .  Impact will display 
a prompt that the correcting receipt will cause an overdraft and not let you do a receipt correction.  
You may not do a receipt correction on a receipt multiple times.  Impact will display a prompt 
saying a correction has already been entered for this receipt number.  If you find yourself in this 
situation you will need to create two receipts, one for a negative amount out of the originating 
escrow and one for a positive amount into the correct escrow. 

Transfer Funds  

Transfer Funds makes it easier to transfer funds between escrow files that share the same bank. 
Transfer Funds will create a negative receipt from the originating escrow file and a positive 
receipt into the new file with two separate receipt numbers assigned.  Impact will allow 
transferring funds from one branch to another as long as both files are assigned to the same 
bank.  If the from escrow number  and the to escrow number  are in different bank accounts, 
Impact will display a prompt that the files are not assigned to the same bank and not let you do 
the transfer.  You must then do a separate negative receipt out of the original file and a positive 
receipt into the correct file.  If the funds were deposited in the bank you will have to notify the 
bank and transfer funds from the incorrect bank to the proper bank. 
 
To transfer funds from one escrow to another, enter the originating escrow number in the from  
escrow number  field and the new file number in the to escrow number , enter the dollar amount 
of the transfer and the reason for the transfer.  The reason for transfer  will appear on the escrow 
ledger.  Click on OK to proceed or click on the Cancel  button to abort transfer of funds. 
 

 
Transfer Funds will allow you to overdraft the orig inating file .  Impact will display a prompt 
that the correcting receipt will cause an overdraft and require you to click on the OK button to 
proceed or click on the Cancel  button to abort transfer of funds. 
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Release Held Receipts 

Escrow can enter receipts and place Holds  on them.  Escrow can modify the held receipt and 
remove the hold only on the date the receipt was created.  An “H” beside a receipt identifies a 
hold, within a ledger. 
 
Only Accounting users can release holds after the day of the original receipt entry. 
 
To determine what deposits are on hold, prior to releasing holds either “en masse”  or by file, you 
can run the Month End > Held Receipt Report . 
 
There are two options made available under the Release Held Receipts  function: 
 

1. Individual File 
2. All Files 
 

Individual File 

 
 
Individual file  allows the release of all holds within 
the file specified.  Enter your escrow number and 
Impact will display a listing of any receipts placed on 
hold. 
 
Highlight the receipt you wish to remove the hold on 
and click on the Release  button.  Impact will 
immediately release the funds so escrow may 
disburse.   
 
 

All Files 

All files  provides for the release of all holds “x” 
number of days after the receipt date.  Select the 
Bank  and enter a value in the field provided so that 
all receipts that have been held longer than that 
number of days will be released. 
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Print Daily Receipts Journal 

 
The "Daily Receipts Journal” report automatically prints 
at the beginning of the posting cycle, discussed above in 
Daily Work> Post Receipts and Disbursements .  
However, if you want to print just a single detailed 
listing, of unposted receipts, for one branch/bank/day 
combination, this is the function to use. 
 
In some situations, it might be helpful to be able to print 
out the detail of one or more batches to assist in a 
research effort (such as confirming if one receipt item 
was entered into two files using different banks at one 
branch). 
 
Under Print Daily Receipts Journal  select All  for all 
branches or select an individual branch.  Enter the 2 
digit month plus the 2 digit day and press TAB .  Impact 
will produce a listing of all unposted receipt batches for 
the specified parameters.  You may highlight one or 
more batches to print a listing of the receipts generated.  
Select the Print  option you would like to see your listing 
appear in; by Branch and Bank  or by Bank .  Click on 
Print  to proceed or Cancel  to abort the job. 
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Disbursements Menu 

The disbursements menu contains functions related to both checks and wires out.  Several of 
these functions are also available in the Escrow module. 
 
The Disbursements  menu option has the following items: 

• Manual Check Entry 
• Void a Check 
• View Check Status 
• Void Wire Out 
• Unposted Disbursements 

• Display Unposted Disbursements 
• Delete Unposted Disbursements 

• Print Daily Disbursement Journal 

Manual Check Entry 

Use of the Manual Check Entry  screen will allow you to create a check entry for an escrow file 
where the physical check was manually typed.  This is done to log a check that was manually 
prepared - during a power failure, for example. 
 

NOTE: A stock of preprinted, pre-numbered checks should be available for this 
eventuality. 

 
Select Manual Check Entry  from the Disbursements  menu to open the Manual Check Entry  
screen. 
 
Enter an existing escrow number in the Escrow Number  field, and then in the Check Number 
field, enter the check number. 
 
Use the pre-filled date, or in the Check Date  field: 

• type in a date, or 
• click on the box with … just to the right of the date entry area, or use the 

CTRL+D Quick Keys to pull up the Calendar  tool 
 
If appropriate, change the date in the Post  Date field - this is the date the item will be posted – 
this should be later or the same date as the Check Date . 
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Press TAB  or place the cursor in the Payee Name field to fill out the name and address 
information manually, or place the mouse in the Payee Name field, then click on Naf in the upper 
left corner of the screen to auto-fill this information with data from the Name and Address File 
(Naf). 
 
If entering a manual fee check, :T entered in the Payee Name  field will activate the Type  area of 
the screen, and if your company’s configuration is set for fee slips, the Type  will change to Fee. 

Add 

Click on the Add  button on the bottom of the Manual Check Entry  screen to add an unlimited 
number of stub detail lines. 
 
Each stub line description can be up to fifty characters.  Press TAB  to move the cursor to the 
Amount  field, and then enter an amount. 
 
Click on OK to save the entries and return to the Impact desktop. 

Delete 

Place the cursor in the Description  or the Amount  field of a stub line.  Click on the Delete  button 
at the bottom of the Manual Check Entry  screen to remove the stub line.  Click on the Yes 
button on the pop up confirmation dialogue box to delete the stub item. 

Cancel 

Click on Cancel  to abort any entries and return to the Impact desktop. 

OK 

Click on OK save the entries and return to the Impact desktop. 
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Void a Check 

Use this option to void a check that is not flagged as cleared, irrespective of its posted status and 
issue date.  You will also use this function to record that a stop payment has been placed on a 
check. 
 
If your company uses the positive pay function, it will send the fact that the check has been 
voided to the bank involved.  The normal communication method specified by your bank should 
still be used to inform them of a stop payment or void since the positive pay information may not 
fully integrate with the bank’s information systems. 
 
Select Void a Check from the Disbursements  menu to open the Void a Check screen. 
 
Enter an existing check number in the Check Number  field and then click on the Find  button. 

 
 
Highlight a check from the list, and then click on Void  to open the next Void a Check screen.  
You may have a display of multiple checks with the same check number, but each will have a 
unique bank number. Highlight the correct check you wish apply to void, and click on void . 
 
Enter an appropriate memo in the Memo  field, or leave the default description in this field.  If you 
are recording a stop payment, enter “Stop Payment ” in the Memo  field, and provide any bank 
confirmation number or other information your company’s policies require. 
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Press TAB  and then ENTER, or simply click on the OK button to void the check.  If the check is 
voided, the funds will be added back into the escrow account balance.  The funds may then be 
disbursed again. 
 
When a check is voided, and a reconciliation is then done covering the date of the void, the check 
receives a Cleared  status, in addition to its Void  status.  In the event the check subsequently 
clears the bank, users may want to be able to reverse the void, so they can clear the check.  This 
lets the ledger "look" correct.   There is a function, in the Impact Utilities module (Tools > Fix  
Open Check File > Change Check Status ) that would facilitate this change -- but many 
companies block use of this by Accounting.  If this function has been blocked, the 
recommendation is to have a new Receipt Type, for "Voided check - Paid at Bank" created, in 
Receipt Types.  Then the user would use that type, when entering a negative receipt -- providing 
for an audit trail as to who entered the transaction.  The negative receipt would then be cleared in 
a subsequent reconciliation. 
 
Depending on system configuration, you may have the ability to reverse a voided check, following 
these same steps. 
 
If a check has been voided in error, the void can be reversed. 
 
Note:  as was noted above, once the void date has been reconciled through, the void will have a 
cleared status and a reversal will not be permitted without changing the status of the check (see 
the discussion in the Void a Check section above). 
 
The same function is used to reverse a void as was used to create the void: Void a Check .  
When the branch and bank and check number are entered, for the item to be reversed, a 
message will be presented: 
 

***** Check has already been voided ***** 
 
If you proceed this void will be reversed . 
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Click on the OK button to confirm that the void should be reversed. 

View Check Status 

To quickly determine if a check has been reconciled as having cleared the bank, or has been 
voided, use this option. 
 
Select View Check Status from the Disbursements  menu to open the View Check Status 
screen. 
 
The Branch Number , Bank , and Check Number  fields must have entries in them. 
 
Click on the Branch Number  drop down list arrow to choose a name from the list.  If you are not 
sure what branch the check was assigned to, select ALL .  Impact will search all branches. 
 
Click on the Bank  drop down list arrow to choose a name from the list.  You may also select ALL 
for the bank and Impact will return any checks with your specific check number drawn on any 
bank, because Impact will allow common check numbers in different bank accounts. 
 
Enter an existing check number in the Check Number  field, and then press TAB  to view the 
check status.  The far right Status  column shows the check status, for example, it may be voided, 
cleared by the bank, or not cleared by the bank. 
 
The cleared status is updated when a bank reconciliation is posted.  More accurate cleared dates 
will be recorded if daily reconciliations are being done. 
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Click on the View Ledger  button to view the Regular Ledger screen.  See the discussion of the 
Regular  option, in the Escrow & Savings Ledgers  section of the Misc.  menu option. 
 
Click on the View Check  button, to open the View Check  screen. 
 
The View Check  screen shows the following check information: Escrow Number , Bank , 
Branch , Date, Amount , Payee Name , Address , and the Memo Line . 
 

 

Void Wire Out 

The Void a Wire   screen acts like the void a check  screen. 
 
Select Void a Wire from the Disbursements  menu to open the Void a Wire screen. 
 
Enter an existing wire out number in the Wire  Number  field and then click on the Find  button. 
 
Highlight a wire from the list, and then click on Void  to open the next Void a Wire screen.  You 
may have a display of multiple wires with the same wire number, but each will have a unique 
bank number. Highlight the correct wire you wish to void. 
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Note:  If you do not know your wire number, see Misc> Escrow and Savings Ledgers> 
Regular  Ledger, select the file involved, and look under Disbursements in-Process. 
 

Unposted Disbursements 

Display Unposted Disbursements 

The Display Unposted Disbursements  option allows the user to view on screen the 
disbursements in a given batch.  Select the Branch Number  from the dropdown menu or enter 
All  to see all available unposted disbursements; TAB  and select the Bank Number  or enter All 
to see all available unposted disbursements; TAB  and enter a 6 digit date or enter All  to see all 
disbursements. Click on Cancel  to exit this screen.  
 

Delete Unposted Disbursements 

The Delete Unposted Disbursements  option allows the user to delete a disbursement from an 
unposted disbursement batch.  This feature is used rarely; usually on occasions where the wrong 
check number was assigned to a check.  The user would delete the check and add it back in 
through manual check entry with the proper check number.  This procedure would only be used if 
you are using preprinted checks or checks with pre-assigned check numbers.  Select the Branch 
Number  from the dropdown menu or enter All  to see all available unposted disbursements; TAB  



Disbursements Menu 
─────────────────────────────────────────────────────── 

─────────────────────────────────────────────────────── 
USA Digital Solutions, Inc. 
Accounting v5.12.0 Manual Page 35 of 98 5/30/2007 

and select the Bank Number  or enter All  to see all available unposted disbursements; TAB  and 
enter a 6 digit date or enter All  to see all disbursements. Click on Delete  to remove a check from 
the unposted batch or click on Cancel  to exit this screen..  

Print Daily Disbursement Journal 

Select the Print  Daily Disbursements Journal  from the Reports  menu to generate a listing of 
the current day’s disbursement activity.  
 
Highlight one or more items on the list in the center of the screen. 
 
In the Print Options  area of the screen, click on the 
appropriate radio button to create a report generated 
By Branch & Bank  or By Bank . 
 
Click on Print  to open the print dialogue box where 
you can click the appropriate button to Print , Preview 
before printing, Email  the document, or Cancel  to 
return to the previous screen. 
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Wires Menu 

There are a maximum of three items on the Wires  menu, depending on the configuration of the 
system at your location.  There are workflow cycles for the handling of incoming wires and for 
outgoing wires, which can be turned on or not, as the company desires.  This documentation will 
assume that both functions are turned on.  In both functions, Escrow initiates the cycle by 
entering information about an anticipated incoming wire, or desired outgoing wire.  Data is then 
made visible in Impact Accounting, where the transaction is confirmed.  The three menu options 
are: 
 
 Incoming 
 Outgoing 
 Print Unposted Wires Journal 

Wires – Incoming  

The Accounting user(s) responsible for tracking incoming wire information at the bank(s) will pull 
that information, and then go into this function to “match up” the bank information with data 
entered by the Escrow users.  The Escrow users should have entered information about 
anticipated incoming wires.  If they have, they will appear as shown below 
 
Note:  Funds attributable to an incoming wire initiated by Escrow are not available for 
disbursement until “approved” by Accounting. 
 
If Escrow has not entered information about a receipt that Accounting has received, the 
Accounting user will not utilize this function to record the wire, but will use the Receipts – Create  
& Modify Receipts  function to enter the receipt for the wire directly into the escrow involved.   
 
Each company will have their own process for trying to identify the escrow for unclaimed wires. 

 

Delete 

The accounting user may delete a wire in entered by escrow in error. Highlight the entry to be 
deleted then click on the Delete  button to remove a pending wire in. 

Cancel 

To exit the wire in screen click on Cancel  . 
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Modify 

Accounting will highlight the wire that they have matched with a bank notification, click on the 
Modify  button, and the overlaying screen will be presented.  If the wrong wire has been selected, 
hit the Cancel  button to go back to the listing screen. 
 
On the screen below, the Accounting user may modify the amount of the wire – if it does not 
match the bank information.  The other information should be checked as well, and edited if 
necessary. 
 
The Federal Wire System tracking number, provided by the bank, should then be entered into the 
Tracking Number  field.  Impact will track the user who released the incoming wire and the date it 
was released. 
 
 
Once all of the information is correct, click on the OK button.  At that time, a receipt is generated 
for the escrow file, and it will appear “in process” in the ledger.  In addition, an e-mail may be sent 
to the escrow officer on the file to let them know the wire has been received and approved, as 

well as to the individual who entered the initial wire information (escrow assistant, for example).  
The prompt for an e-mail verification when the wire has been approved is a separate option in the 
Impact configuration.  Depending on your company’s settings this may or may not be turned on.  
Once approved the funds are then available for disbursement out of the escrow file. 
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History Tab 

A History tab  is available for each file which will show the status of all wire ins for that escrow 
number.  A Pending  status means the wire in is still sitting in the incoming wire queue, awaiting 
approval by an accounting user.  A Received  status means the incoming wire has already been 
approved and the funds released to the escrow file. 
 

 

Sort 

You may sort the listing of the items ready for a wire in approval.  This sort  may be your 
permanent display.  You have 6 available fields for sorting: the escrow number, branch 
number, the amount, customer name, the receiving ba nk name and the escrow officer .  
Highlight an available field and click on Add  to start your sort hierarchy, or you may click on 
Defaults  and Impact will sort the items by sending bank name and date submitted.  Click on the 
OK button to activate your sort or click on Cancel  to return to the incoming wire screen.   

 
Impact will display a prompt asking if you would like to make these sort parameters your default 
setting.  Click on the Yes button if you want Impact to keep the sort parameters as your normal 
display order or click on No to have Impact return to the default parameters the next time you 
access the incoming wire screen.  
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Wires – Outgoing  

Outgoing wires are considered disbursements in Impact/SQL, and have their own unique 
sequence numbering scheme (set in Misc.>Set up Branch>Bank Information ).  The following 
discussion assumes the Wire Out Processing functionality is turned on (see the end of this 
discussion for an explanation of what is seen if the module is not turned on). 
 
This module is very similar to the incoming wire module, in appearance, but a primary difference 
is in the treatment of the funds.  Whereas in managing incoming wires the funds are not available 
until approved by Accounting, with outgoing wires the funds are immediately removed from the 
file (when Escrow enters the information about the wire out before Accounting has really done the 
wire out).  This ensures that the funds are not wired out a second time, and prevents a check 
being cut.   
 
Escrow initiates the outgoing wire in the Escrow module .  Once completed, the funds (as was 
noted above) are immediately subtracted from the available funds in the escrow file.  A pending 
outgoing wire appears in the Accounting module , on the Wires > Outgoing  screen. 
 

 
Note:  If your system is set for dual authorization on wire outs Accounting will not have the wire 
out available until it has been approved by an escrow approver. 

Sort Wire Outs 

The Accounting user may sort the list of outstanding wire outs.  The sort fields available are the 
amount, escrow officer name, bank number, branch nu mber , and by notes  the Escrow user 
might have placed on the wire out. 
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Modify A Wire Out 

Once Accounting personnel have physically completed the outgoing wire, with the bank, and 
have received the confirmation containing the Federal Wire System tracking number, they can 
then complete the cycle in Impact Accounting.  The pending wire is highlighted from the list 
screen, and the Modify  button is hit.  The screen below is then displayed. 

 
The outgoing wire confirmation screen presents all of the data entered by Escrow.  Accounting 
should confirm that all of the data remains correct and that the amount entered is in fact what was 
wired out. 
 
Accounting enters the Tracking Number .  Once all is confirmed to be correct OK is hit.  If you do 
not wish to confirm the wire, hit the Cancel  button.  Once OK is hit, a wire out notice is generated 
and the escrow officer and person who initiated the wire out (if different) may be e-mailed a notice 
that the bank has in fact processed the wire.  At this time a unique wire out number is assigned to 
the wire and it is placed in the disbursements-in-process batch ready for posting during the Daily 
Work>Post Receipts and Disbursements . 
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Print A Wire Out (Unselect All or Select All) 

Accounting has the ability to Select All  the wires and print a wire out form for each wire, or 
Unselect All  once you have Selected All .  Accounting may also highlight an individual wire and 
Print  the wire out form if needed.  

Delete A Wire Out 

Accounting has the ability to Delete  a wire out.  When a wire out is deleted, the funds are added 
back into the escrow file.  If accounting needs to Delete  a wire out, they must tell the escrow 
officer on the file so escrow can issue a new wire out or disburse the funds. 

Add A Wire Out 

Accounting has the ability to Add  a wire out from the wire out screen, if the option in the Utilities  
module > System Files > Setup Options> General Tab  is flagged for Enable Manual Wire  
Outs in Accounting .  The Accounting user will see the following screen under Wires> Outgoing  
(instead of the one above), after selecting the escrow involved.  The Available Balance  is 
shown, and the Date field is pre-filled (but can be altered).  There are two fields for description of 
the wire out, Wire To  and Description , and the dollar amount of the wire is entered in the 
Amount  field.  On clicking OK, a notice will be printed, and the wire out disbursement is entered 
into the In Process  batch for the branch, and can be seen on the Disbursements In Process  
tab within the regular ledger.   
 
If the Wire Out Processing module is not  turned on, the Accounting user will see the same 
screen, Add a Wire , with the same functionality.  
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History Tab 

The History Tab  displays all outgoing wires entered into the system for the selected escrow.  
This should be checked before entering a wire, just to confirm a duplicate is not entered. The 
History Tab  shows the Status  of a wire out; Sent  means accounting has confirmed the wire; 
Initiated  means Dual Authorization  is set and the Escrow user has not released the wire to 
accounting; Approved  means the Escrow user has released the wire to Accounting, but 
Accounting has not confirmed it. 
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Print Unposted Wires Journal  

The Unposted Wires Journal  will give the Accounting user a listing of all wires incoming and 
outgoing that have been approved by Accounting and are sitting in a daily unposted accounting 
batch.  The user may select All  for all branches, All  for all dates that have unposted batches with 
wires included in the batches, or they may enter a specific date.  Once the daily work is posted 
under Daily Work > Post Receipts & Disbursements   the unposted wires journal will display no 
wires available for posting.  The user may select how they want their report to be sorted, By 
Bank or By Branch . 

 

Wire Outs On Hold  

Depending on your company’s configuration you may see a Wire Outs On Hold Report .   If the 
feature to set a wire out on hold is enabled for the escrow user they may create a wire out and 
place it on hold.  Once a wire out is placed on hold by the Escrow user Accounting will not see 
the wire out in the outgoing wire screen until Escrow removes the hold date. This report informs 
the Accounting user Escrow has placed a wire out on hold.  If you are using the hold feature this 
is a handy reminder so Accounting can remind escrow to remove the hold date on the wire out, 
so it may be processed.  The Wire Outs On Hold Report  shows the escrow number, bank 
number, the date the wire was created, the reason t he wire was placed on hold, the 
customer name and the amount .  This report may be generated By Branch, Bank, or By 
Escrow Officer, all or specific . 
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Month End Menu 

 
The functions located on the Month End  menu can all be run at any time during the month, with 
the exception of the Close Month  function.  Generally, the reports generated from this menu are 
run “as of” the month end, and therefore the Month End  menu name.   
 
Most of the functions located on the Month End  menu have a variety of options which generate 
reports that can provide you with many useful tools.  Printed copies of several of these reports will 
comprise the Accounting Department’s documentation of the transactions completed during the 
month, and will be kept along with the reconciliations of the trust account(s).   
 
The Month End  menu option may have up to fifteen items under it: 

• Escrow Trial Balance Reports 
• Standard Trial Balance 
• Audit Trial Balance 

• Savings Trial Balance Reports 
• Standard Trial Balance 
• Audit Trial Balance 

• Receipts Journals 
• Deposit Journals 
• Disbursements Journals 
• Check Registers 
• Escrow Aging Reports 
• Overdraft Reports 
• Held Receipt Report 
• Dormant Escrow Report 
• Ledger Activity Report 
• Bank Register 
• Close Month 
• Wires Journal 
• Bank Overdraft Audit 

 
After making choice(s) on the report options screen that you opened from the Month End  menu, 
and you click on OK, a print dialogue box will open from which the report can be previewed 
before being printed, or depending on your company’s configuration, e-mailed instead.  From the 
preview screen, the report can be exported into an assortment of file types, if you need to 
preserve an electronic copy of a report.  To determine which electronic file formats are available, 
click on the envelope icon in the upper left-hand corner of the preview screen, and review the 
dropdown list of file types available.    

Escrow Trial Balance Reports 

The Standard Trial Balance  is one of the most important reports for a variety of reasons.  The 
report, as can be seen from the option screen below (which opens when the report is selected 
from the menu), has a variety of permutations that can be run.  Which version is run will depend 
on the immediate purpose of the report being run, and the structure of your business.  The Trial  
Balance report  will present one line of information about each escrow file’s posted ledger 
balance as of the date of the report. 
 
The options that are available deal with branch, bank, escrow officer, zero balances, and 
length  of time files have been open .  Formatting options involve buyer/seller names, held 
funds  descriptions  and whether detailed ledgers  should be printed.  The first option to be set is 
the Trial Balance  as of date of the Trial to be generated.  This date cannot be later than the date 
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of the last posting, which is displayed at the top of the option screen.  You may run the Trial for 
any historic date.  Generally, the date selected is a month end date, but that is not required to be 
the case. 
 
Some examples: to provide a branch manager, of a branch with more than one bank account, 
with a full Trial Balance, you would run the report By Specific Branch , as this will include a 
record for every file with a balance, in the branch specified, regardless of the bank assigned to 
the files; to generate a trial to support the Trial total used in an account reconciliation, you would 
run the report By Specific Bank , for the date of the reconciliation; and, to run a Trial to support a 
cleanup project of aged files that still retain funds, you could run a Trial by Escrow Officer , 
show only files  open for “x” months or longer , and include the held funds descriptions . 

Standard Trial Balance 

Select Standard Trial Balance from the Month End menu to open the Trial Balance screen. 
 
The Date Last Posted  is shown, and the Trial Balance as of date field is pre-filled but can be 
altered by entering a new date or you can click on the box with “…“ just to the right of the date 
entry area, or use the CTRL+D Quick Keys, to pull up the Calendar  tool. 
 
Click on the appropriate radio button to create a report generated By Branch, By Escrow 
Officer , or By Bank .  Alternatively, to generate the report By Specific Branch , etc., choose a 
radio button from the center of the screen and also select an item from the corresponding drop 
down list box to the right. 
 

 

Print Options 

The Accounting user has multiple Print Options  to chose from.  You may print the Standard 
Trial  Balance  without any specific options, or chose one or more options from the Print Options .  
The default print option will generate a listing of all files with a balance  with the following 
columns:  escrow number, branch number, escrow officer’s init ials, ledger balance, 
savings balance, last transaction date, open date, close date, record date  and policy date . 
 
The Include Zero Balances  will give you the Standard Trial Balance  with the default print 
options and show all files opened through the as of date . 
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The Show only files open for x months  or longer option will give you the Standard Trial  
Balance  with the default print options, but only show files that have an open date equal to or less 
than the number of months specified. 
 
The Include Buyer/Seller Names  will replace the last transaction date, open date, record 
date,  and policy date  of the default print option with the Buyer and Seller last name. 
 
The Include Held Funds Description  will give you a Standard Trial Balance  with the Include  
Buyer/Seller Names  plus a reason why funds are remaining in an escrow file after the revenue 
check has been issued.  The Held Funds Description  is input by the Escrow user when they 
disburse their revenue check and there are funds remaining in the file. 
 
The Print Ledgers  will generate a history to date ledger for each file listed on the Standard Trial  
Balance  with the Print Options  selected. 
 
Note:  The  Accounting user may check multiple Print Options .  

 
Click on OK to open the print dialogue box, where you can click the appropriate button to print 
OK, Preview before printing, Email  the report, or Cancel  to return to the previous screen. 
 
 
 

 
 

Audit Trial Balance 

The Audit Trial Balance  is different from the Standard Trial Balance  in that it covers a date 
range, rather than being as of a specific date.  It is designed to report, in summary form, on all 
accounting activity within files over the period specified.  Generally, this would be run for a one-
month period, and would show you the beginning balance , file-by-file, and the receipts and  
disbursement totals  that resulted in the ending balance .  A sample of this report’s layout is 
presented below.  The sort is the same as the Standard Trial: escrow file within branch (if the 
report is run by branch). 
 
Select Audit  Trial Balance from the Month End menu to open the Audit  Trial Balance screen. 
 
The Date Last Posted  is shown, and the Trial Balance for date field is pre-filled from the 
beginning of the month through the current posting date, but can be altered by entering a new 
date or you can click on the box with “…“ just to the right of the date entry area, or use the 
CTRL+D Quick Keys, to pull up the Calendar  tool. 
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Click on the appropriate radio button to create a report generated By Branch, By Escrow 
Officer , or By Bank .  Alternatively, to generate the report By Specific Branch , etc., choose a 
radio button from the center of the screen and also select an item from the corresponding drop 
down list box to the right. 
 

Print Options 

The Accounting user has multiple Print Options  to chose from.  You may print the Audit Trial  
Balance  without any specific options, or chose one or more options from the Print Options .  The 
default print option will generate a listing of all files with a balance  with the following columns:  
escrow number, branch number, escrow officer’s init ials, beginning ledger balance on the 
from date, total receipts based on the from / throu gh date, total disbursements based on 
the from / through date, the ending balance based o n the through date and the last 
transaction date.  
 
The Include Zero Balances  will give you the Audit Trial Balance  with the default print options, 
and all files opened within and including the from / through date. 
 
The Print Ledgers  will generate a history to date ledger for each file listed on the Audit Trial  
Balance  with the Print Options  selected. 
 
Click on OK to open the print dialogue box, where you can click the appropriate button to print 
OK, Preview before printing, Email  the report, or Cancel  to return to the previous screen. 
 
 



Month End Menu 
─────────────────────────────────────────────────────── 
 

─────────────────────────────────────────────────────── 
USA Digital Solutions, Inc. 
Accounting v5.12.0 Manual Page 48 of 98 5/30/2007 

 

Savings Trial Balance 

Standard Trial Balance (Savings) 

These reports are similar to the Standard Escrow versions, but report on Savings (Interest 
Bearing  Accounts)  information, file-by-file.  As there are, potentially, many banks involved with 
savings, the reports have an added break by bank, and present the various account numbers 
within each savings bank.   
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Print Options 

The Accounting user has multiple Print Options  to chose from.  You may print the Savings Trial  
Balance  without any specific options, or chose one or more options from the Print Options .  The 
default print option will generate a listing of all files with a balance  with the following columns:  
escrow number, branch number, escrow officer’s init ials, savings bank account number, 
savings balance based on as of date, escrow open da te, escrow closed date and escrow 
record date. 
 
The Include Zero Balances  will give you the Savings Trial Balance  with the default print 
options, and all files opened through the as of date . 
 
The Print Ledgers  will generate a history to date ledger for each file listed on the Savings Trial  
Balance  with the Print Options  selected. 
 
Click on OK to open the print dialogue box, where you can click the appropriate button to print 
OK, Preview before printing, Email  the report, or Cancel  to return to the previous screen. 

Audit Trial Balance (Savings) 

The Audit Trial Balance  (savings) looks similar to the Audit Trial Balance  under the Standard 
Trial  Balance  but includes an interest column, in addition to total receipts  and withdrawals . 
 

Receipts Journals 

The Receipts Journals  (again, there are several variations), as a group, present detail of each 
receipt entered, and subsequently posted, into Impact, during the period specified.  The same 
branch and bank selection criteria available for the Trial Balance reports are available for the 
Receipts Journals .  When any of the options involving bank are selected, you will also be able to 
identify which of the deposit-related print options to include in the report.   
 
This flexibility provides useful reports for the account reconciliation process.  When preparing to 
balance to the book balance, within a reconciliation, you may need an adjustment for undeposited 
receipts.  To determine what that amount is, and to provide the detail to support it, you will 
generate a receipts journal for the specific bank account being reconciled, for a date range 
ending with the reconciliation date, with the Undeposited Items Only  option selected. Generally, 
this would be just one month, but if there are undeposited receipts from earlier, the date range 
should be extended back to include the older items. 
 
Note:  If you select the Print Option  Include Deposit Information  or Undeposited Items Only  
you must use the Print Selection  for Banks  or By Branch and Bank . 

 
Note:  If the system is set to automatically enter the undeposited receipts adjustment to the bank 
reconciliation you will not need to enter an adjustment. 

 
The Receipts Journal  includes the following fields from left to right, Receipt Number, Date,  
Escrow Number, Payor Name, Receipt Type and Amount .  If the option is selected to Include  
Deposit Information , the columns Deposit #  and Deposit Date  are added on the right side.  
That is also true if the Undeposited Items Only  option is selected, but the deposit information 
will either be blank or will reflect deposits made after the end date of the period selected. 
 
You may also run the reports sorting by Receipt Type .  The layouts are the same, with the 
inclusion of sub-totals by receipt type. 
 
It is strongly recommended that a full Receipts Journal , by bank account, for each month, be 
kept with the month-end reconciliation for that account.  This will provide the detail on all receipts 
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entered during the month that may be required when researching issues down the road.  Keep in 
mind that the prior month’s Trial Balance , plus the total of the Receipts Journal , less the net 
Disbursements Journal  should result in the Trial Balance  total for the current month-end. 
 
 
 

 
 
 

Deposit Journals 

The Deposit Journal  presents details of depositable receipts that have been included in deposit 
slips within the date range specified.  Some receipt types are depositable, others are not.  An 
item would be depositable if it is a physical item that will be taken to the bank for deposit, such as 
an earnest money check.  Care should be taken by Escrow, when entering receipts, to only select 
a receipt type for depositable items for those items that will be included on a deposit slip.  Book 
transfers, wires and book adjustments are not depositable items, and so should not be given a 
receipt type that is defined as depositable.  These settings are managed in the Utilities module> 
User Tables> Receipt Types .   
 
You may select to print the report with all bank accounts being reported, or a specific account.  
The Deposit Journal  can be presented in two ways: by receipt date  or by deposit date .  If 
presented by receipt date , the report only totals by bank, and is very similar to a Receipts 
Journal , except only items included on deposit slips are presented.  The report by deposit date  
provides summary totals by deposit ticket number.  This report is very helpful when trying to 
understand discrepancies in deposit information presented on a bank statement.  You can look to 
see if there are any items within a deposit that the bank may not have received or accepted 
which, by their removal from a deposit, would result in the deposit figure presented on the bank 
statement. 
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Disbursements Journals 

The Disbursements Journals  present detail of each disbursement entered, and subsequently 
posted, into Impact, during the period specified.  The same branch and bank selection criteria 
available for the Trial Balance  reports can be used for the Disbursements Journals .  You may 
generate a Disbursements Journal  sorted by disbursement type, rather than by disbursement 
number, if you so desire. 
 
The layout of the standard Disbursements Journal  includes Disbursement Number, Date, 
Escrow  Number, Branch, Escrow Officer, Name (payee), Manua l (check) and Amount .   The 
bank account will be identified in the title header information (under the date, in the top left), and 
sub-totals will be presented by bank account.  Note, also, that totals of voided items and the 
amount of reversed voids are provided.   
 
As with the Receipts Journal , it is strongly recommended that a full Disbursements Journal , by 
bank account, for each month, be kept with the month-end reconciliation for that account.  This 
will provide the detail on all disbursements entered during the month that may be required when 
researching issues down the road.  Keep in mind that the prior month’s Trial Balance , plus the 
total of the Receipts Journal , less the net Disbursements Journal  should result in the Trial 
Balance  total for the current month-end. 
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Check Registers 

The Check Registers  are limited to reporting on posted checks specifically, not all 
disbursements (which include outgoing wires).  The standard report will present all check 
information that meets the criteria selected.  In addition, a report can be generated of only voided 
checks that meet the criteria.  There are three basic types of Check Registers : one covering all 
checks issued within a date range; one of checks that were outstanding (uncleared via a 
reconciliation) as of a specific date; and, one of checks outstanding (uncleared) over a specific 
number of days.  The second and third report types are useful in working stale-dated checks.  
The same branch and bank selection criteria are available for Check Registers  that are available 
for the other reports.  In addition, a Check Register  can be run for any one or all escrow officers.  
The user may also run a Void Check Register  of all the checks that were voided in a time frame. 
 
 

 
The fields presented in  a Check Register  are: Check Number, Check Date, Escrow Number,  
Check Amount, Payee Name and Manual (check) .  The totals include the sum of checks 
issued, a sub-total of current period checks voided, a sub-total of checks voided that were issued 
prior to the period selected for the report, and finally a net total of checks issued and not voided. 
 

Escrow Aging Reports 

The Escrow Aging Report  looks like an accounts receivable aging that might be generated out 
of a Financial Accounting system.  The report distributes escrow ledger balances across aging 
buckets, since Closed Date, of 30-59 days, 60-89 days and over 90 days .  While savings 
balances are presented on the reports, they are not distributed with the escrow balances.  This 
report helps the user visualize the degree to which the Trial Balance  is aged, or how long the 
files with balances have been closed.   
 
Note:  the Date Last Posted is presented on the screen to remind the user that this is the latest 
date that the report will be meaningful for. 
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The only selection criteria for this report are the Aging  as of date, and whether you wish the 
report by Branch  or by Escrow Officer .  If a specific branch or escrow officer is identified, the 
report will be limited to the one, otherwise Branch or Escrow Officer will generate a full system 
report with sub-totals, as requested. 
 

 
 
The fields presented in an Escrow Aging report are: Escrow Number, Escrow Officer, Open 
Date, Closed Date, Date Recorded, Ledger Balance, S avings Balance, 30-59 Days, 60-89 
Days and 90+ Days. 
 
Note:  as the balances in files that are less than 30 days old are not distributed in the aging 
buckets, the sum of the buckets from the report totals will not total the overall ledger balance. 

 

Overdraft Reports 

The Overdraft Reports isolate those files that have a negative ledger or savings balance, as of a 
specific date.  You will not be able to generate the report beyond the date last posted , which is 
presented on the screen.  The routine Branch and Bank  selections are possible, along with 
Escrow Officer .  There are two versions of the report: the standard report  (like the Standard 
Trial Balance layout) and one that presents less date information but which includes buyer and  
seller names  as well as the reason for the overdraft , if one was entered. 
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The standard Overdraft Report  includes: Escrow Number, Branch Number, (EO) Initials, 
Ledger Balance, Savings Balance, Open Date, Close D ate, Record(ing) Date, Type Date 
and Policy Date . 
 

 
 
The alternative layout looks like this, replacing the dates with Buyer, Seller and Overdraft 
Reason: 
 

 
 

Held Receipt Report 

The Held Receipt Report  will identify receipts that have been entered and flagged on hold.  The 
report can be run by branch, by escrow officer  or by bank  (all or specific for any category).  
There is no date criterion, as historic hold dates are not retained by the system; the report is 
simply as of the time it is run.  This report should be run before a release all held funds  step is 
taken (Receipts >  Release Held Receipts > All Files ), to make sure you wish to do that. 
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The resulting report layout displays, from left to right Escrow Number, Date (of the receipt), 
Receipt Number, Initials, Type (of receipt), Bank N umber, Payor and Amount . 
 

 
 

Dormant Escrow Report 

The Dormant Escrow Report  identifies files that have been open quite some time, and that have 
balances.  The Dormant Escrows Report  is designed to help in working aged files.  Along with 
the normal Branch, Escrow Officer and Bank  criteria, there are two print options that can help 
you focus attention on files with no accounting activity (no receipts or disbursements) at all for 
over “X” number of days, or on all files that have been open more than “X” number of days.  The 
report can be generated for any date up through the Date Last Posted . 
 

 
 
The layout of the Dormant Escrow Report  is presented below.  The fields displayed are, from 
left to right: Escrow Number, Branch Number, (EO) Initials, Ledger  Balance, Savings 
Balance, Open Date, Close Date and Transaction Type . 
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Totals by the Print Selection (Branch, Escrow Officer or Bank) criteria are provided on the report, 
along with a grand total. 
 

 
 

Ledger Activity Report 

The Ledger Activity Report will generate a series of ledger printouts for every file that had 
activity (receipts &/or disbursements) during the date range specified.  The activity presented will 
be all activity that is in the system for each file, regardless of date, as long as one of the items 
falls within the date range.  The Posted Balance  presented on the ledgers, however, will be 
through the end of the date range specified (even if there are items presented after the end of the 
date range).  For this reason, care should be taken on the date range called for, it really should 
end with the Last Posted Date , and generally would begin with the first date of that month, to 
provide a ledger printout for every file touched within the month.  The posted balances would then 
match the Trial Balance  data printed for the same ending date.  The posted balance will not 
necessarily incorporate all of the transactions presented (items presented dated later than the 
period end date will not be included in the posted balance).   
 
The standard Branch, Escrow Officer  
and Bank  selection criteria are 
available.  Should you wish to exclude 
files that had a zero balance at the end 
of the period specified, you can select 
that print option. 
 
The ledgers generated look the same as 
those presented under the Misc. > 
Escrow & Savings  Ledgers > Regular  
menu path in Impact Accounting  with 
the caveat on the Posted Balance  
discussed above. 
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Bank Register 

The Bank Register  is a bit of a misnomer, as while the report looks like a bank register 
(beginning balance, then a listing of transactions in and out, leading to an ending balance) it 
reports on ledger activity (receipts and disbursements), not cleared bank items.  To run the 
report, you must supply a bank account , and a date range .  There is a detailed version (all 
receipts and disbursements listed one-by-one, ordered by date and reference number), and a 
summary version that displays daily activity totals, by type of transaction (deposits, checks, wires 
in, etc.). 
 

 
 
 
A sample of the detailed layout is shown here.  The fields presented are, from left to right, Date, 
Escrow Number, Reference No., Description, Amount a nd Balance .  The Balance is a 
running Trial Balance  total for the bank account being reported on, after each transaction is 
recorded. 
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Close Month 

The Audit Accounting Data  function should be utilized prior to selecting the Close Month  menu 
option.  Refer to the instructions in the Audit Accounting Data  part of the Daily Work  Menu  
section for further explanation of this procedure. 
 
The Close Month  function clears out the running, month-to-date tallies, by branch and bank, 
which are maintained within the system, and moves the month-end totals to the beginning-of-the-
month buckets.  The Close Month  function must be run, but only after the posting of the last 
calendar day of each month, and only after a clean audit has been run (Daily Work > Audit  
Accounting Data ).  Normally, the last calendar day is posted, and then an audit is run.  If any 
maintenance is required, based on the audit findings, then it is entered and posted, still within the 
month not-yet-closed, and another audit is run.  Once the audit is clean, the month should be 
closed.   

 
A report of full-month activity, in summary form, by branch, will print before the balances are 
cleared.  There is no way to re-print this report, so be sure it is not thrown away. 

Wires Journal 

The Wires Journal  gives a listing by date range of all the posted wire ins and posted wire outs.  
This is a handy report in that you don’t have to produce a Receipt Journal  for the wire ins and a 
Disbursement Journal  for the wire outs.  All wires are on one report. The standard Branch, and 
Bank selection criteria are available.  You may also sort the report by wire ins first then wire outs. 
The wires journal will show the reference number assigned to the wire, the date of the wire, 
escrow number, bank number, the escrow officer, who  the wire was from or paid to, and 
the amount . 
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Bank Overdraft Audit 

The Bank Overdraft Audit produces a listing by selected bank of all the cleared deposits and 
cleared checks against that bank.  This report is used to determine if a bank is overdrawn. 
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The report shows the total receipts, the total receipts cleared, the tot al disbursements and 
total cleared disbursements .  The cleared flag on a receipt and disbursement are generated 
through a bank reconciliation.  A sample of the report is shown below. 
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Recon Menu 

The Reconciliation menu contains two items: 
 

 Reconciliation 
 Outside Service 
 

These are both used to start new reconciliations of escrow trust accounts (either daily or 
monthly).  If the company receives downloads of data from their bank(s), in a form that Impact 
can utilize (there are many), then they would use Outside Services  to start each reconciliation.  
Consult with your bank as to whether they can provide a download, and then consult with USA 
Digital Solutions to determine if an existing “filter” will read the bank’s file, or whether a new filter 
needs to be developed.   

Reconciliation 

If your bank does not provide a download of statement activity, or if you prefer to clear all items 
manually, you will start your reconciliations with the Reconciliation  menu item. 
 
Whichever approach is used to start the reconciliation, the next screen you will see, if a 
reconciliation has not already been started, is presented below.  Should you get a warning that a 
“reconciliation already exists” and “are you sure you wish to start over?”, be careful how you 
respond!  If you do start over, all work in the existing reconciliation will be lost, and the uncleared 
items will be reloaded.  Sometimes this is necessary.  Normally, if you get this message, you 
have a reconciliation in process, and have done a Save & Exit  from it, and are just returning to 
the reconciliation to continue working on it.  You will always use the Reconciliation  menu item to 
return to an active reconciliation. 

 
 
The Bank field will be filled in, if Outside Service  was used.  You will then enter the Statement 
Date of the bank statement being reconciled.  The Beginning Balance  should contain the value 
retained from the last reconciliation’s Ending Balance , and you should enter the Ending 
Balance  from the bank statement to be reconciled.  Then click the OK button.   
 
If you see you are starting a reconciliation for the wrong account, click Cancel . 
 
Once you click on OK to build the reconciliation table, the system will load all uncleared items 
issued on or before the date of the reconciliation (and autoclear what it can, if you are using 
Outside Service ).  You will then be presented with a screen like the one shown below. 
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At the top of the screen are two menu headings: Print  and Tools .  The Print  menu has three 
reports under it: Cleared Items Report, Uncleared Items Report and Summary Report .  You 
may wish to print part or all of one or more of these reports during the reconciliation effort, and 
you definitely should print all three of these reports before you post the reconciliation.   
 
Note :  There is no way to reprint these reports after the reconciliation is posted. 
 
The Tools  menu has three items under it as well: Sort, Search and Change Statement  
Balances .  These tools can come in handy when working on reconciliations.  You can sort the 
table on a series of columns, and you can search any column for a specific entry.  If you find you 
have entered the statement ending balance incorrectly, you can correct it from here. 
 
The next thing to note is that there are two tabs on the screen: Bank Statement  and Book  
Balance .  These two tabs provide the functionality to balance first to the bank statement and then 
to balance the bank statement to the Trial Balance  (the ‘book’).  It might be helpful to think of the 
Bank  tab as dealing with cleared items and the Book  tab as dealing with uncleared transaction 
totals by type and unresolved adjustments.   
 
If you have to suspend work on a reconciliation in progress, click on Save & Exit .  Only Cancel  if 
you wish to lose any and all changes made since you last saved. 
 
The Mark Range  button is used to trigger a routine that will permit you to bulk clear a range of 
reference numbers for a type of transaction.  For example, you may want to clear all checks in the 
number range 10004 to 10235. 
 
The Add, Delete  and Modify  buttons all relate to adjustments.  To add an adjustment, click on 
the Add  button and a sub-screen will be presented, through which you can enter information 
about the required adjustment.  Provide as much detail as possible in the comment area, to 
minimize your future research efforts. 
 
Note the summary totals and balancing calculations at the bottom of the screen.  There is an area 
like this on both tabs.  On the Bank Statement tab, the summary figures are of cleared items, by 
type, on the left side, and then bank balancing calculations on the right side.  On the Book 
Balance tab, the figures are related to uncleared summary totals, and the balancing is from the 
ending bank balance to the Trial Balance .  The reconciliation is in balance when the Difference  
fields on both tabs are zero (0.00). 
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Steps For Completing A Reconciliation 

The following outline of steps details the process for completing bank reconciliations in the 
Accounting module: 
 
1) Get a copy of the bank statement for the period to be reconciled (day or month); a copy should 
be used, as you will be marking it up as things get worked.  As things get worked, mark them up 
on the statement copy...when everything is marked, and notes on all required adjustments have 
been made on the copy, you will have a good reference source for research down the road. 
 
2) Print  the report of Undeposited Receipts : Month End> Receipt Journals , select the specific 
bank account and check the Undeposited Items Only  box, enter the date range for the period 
being reconciled, ending with the date being reconciled through.  You will need this report's 
output for one or more book adjustments, if there are any undeposited receipts. 
 
3) As explained above, open the reconciliation for the period being reconciled (the date entered 
will be the cutoff -- everything that was outstanding through that date will appear in the 
reconciliation).  "Everything" means checks, deposits, WIN and WIO receipts, and outstanding 
book adjustments.  NOTE:  depositable receipts that have not been included in a deposit will NOT 
appear in the reconciliation – thereby requiring one or more book adjustments to tie to the Trial 
Balance report, which includes all posted activity. 
 
4) Assuming you are not using a bank file to "autoclear" checks, start the reconciliation process 
by clearing checks.  You can start with any sub-set (checks, deposits, WIN's or WIO's) -- but it 
helps to work one "type" at a time.  Some bank statements provide totals by type, making it easier 
to confirm each section has been worked properly, before proceeding to the next.    Put the 
cursor on the item you wish to clear and hit the Space Bar  to put an X in front of the item – that 
indicates it is flagged “cleared”.  Alternatively, double-click in the first column in front of the item 
you want to clear.  As you are clearing checks, if there are encoding errors (bank cleared wrong 
amount), enter a bank adjustment for the difference -- if the bank took too much, enter a negative 
adjustment, if too little, enter a positive adjustment.  Flag these (and all) bank adjustments as 
"cleared".  If you did use Outside Service , to start the reconciliation, refer to the exception report 
for likely adjustments required. 
 
5) While clearing WIN's and WIO's, it is helpful to search the reconciliation (use Tools – Search ) 
by the amount on the bank statement, rather than just looking at the items quickly -- in order to 
catch errors in amounts...often a wire will be receipted for one amount, especially if receipted 
based on an estimated amount, but what appears at the bank may be a different number.  As 
discrepancies are identified, enter bank adjustments for each, as identified, and make a note of 
the difference on the bank statement copy. 
 
6) Deposits should then be cleared, again making adjustments for discrepancies.  A Deposit  
Journal  report can be run to provide the detail contained within each deposit, which is helpful 
when trying to understand discrepancies with the deposit amount shown in the reconciliation and 
the amount reflected on the bank statement. 
 
7) Once each "type" has been worked, and all bank adjustments are entered (with the "sign" of 
the adjustment matching the behavior seen on the bank statement -- $$ into the account = 
positive adjustment, $$ out of the account = negative adjustment), you should be in balance with 
the bank.  Calculations at the bottom of the screen will let you know when you are in balance.  
DO NOT TRY TO BALANCE THE BOOK SCREEN UNTIL THE BANK SCREEN REFLECTS AN 
IN-BALANCE CONDITION.  Again, mark all bank adjustments as "cleared", as they are only 
applicable to this reconciliation; book adjustments may carry forward, but bank adjustments do 
not. 
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8) Once the bank screen reflects it is in balance, preview the Cleared Items  report and print just 
the page(s) containing the bank adjustments. 
 
9) Switch to the Book Balance tab.  Enter an adjustment for each "new" adjustment entered on 
the bank screen, but with the opposite sign (if the bank adjustment was positive, enter a negative 
adjustment, and vice versa).  Do not enter a new adjustment for an item that was a "fix" for an 
adjustment already outstanding on the book side, just offset the outstanding book adjustment, 
with a commonly titled adjustment with the opposite amount, and mark both items as “Cleared”.  
This is a good, "auditable" approach.   
 
10) Once the new adjustments have been added, and the old, fixed adjustments have been offset 
and cleared, you should enter one or more adjustments for the receipts that have not been 
deposited.  It is recommended that you enter an adjustment for each future dated deposit, 
especially if they were prepared on different days, so that when the deposits hit the next bank 
statement they can be clearly matched up with the adjustment items in your next reconciliation.  
These would be positive adjustments, as you are grossing up what is in the outstanding deposits 
in the reconciliation to the full amount recorded as receipted in the Trial (remember: all receipts 
are represented in the Trial, only deposited receipts are represented in the reconciliations).   
 
Note:  If the system is set to automatically enter the undeposited receipts adjustment 
you will not need to enter one. 

 
11)  At this point, you should be in balance both with the bank and with the book (the Trial).  If you 
are not, one item to look for are reversals of voids that were done after the date of the 
reconciliation – these will reflect as outstanding checks, even though they are considered voids 
as of the date of the reconciliation and Trial Balance.  Once both sides are in balance, print all 
three of the reports (Summary, Cleared and  Uncleared ).  Be sure you have all three reports 
printed and in hand BEFORE posting the reconciliation.  They cannot be reprinted once the 
reconciliation is posted.   
 
A sample of the Summary Report  is presented here, along with a sample of the Uncleared 
Report .  The Cleared  report is similar to the Uncleared , in format.   
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12) Once the reports are in hand, confirm that the reconciliation is still in balance, both to the 
Bank  and to the Trial , and click on the Post  button to finish the reconciliation.  The system will 
flag as cleared, in the system, all of the items that are marked cleared in the reconciliation.  
Cleared adjustments will be deleted (and will not appear in the next reconciliation).  Uncleared 
adjustments will be retained for the next reconciliation. 

 
 
 
13) Keep the copy of the bank statement, with the adjustment notes, the Undeposited Receipts  
report and the three reconciliation reports, all bundled together.  You also want to keep a copy of 
a full Receipts Journal  and a full Disbursement Journal  for the period being reconciled.  In 
addition, print a Trial Balance Report  as of the reconciliation date.  With these you can confirm 
that the system is in balance by taking the beginning Trial, add receipts, subtract net 
disbursements and you should get the ending Trial figure. 
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Once the reconciliation is posted, the output must be reviewed: 
 

a) Look at the Uncleared Items report – especially the uncleared deposits and WIN and WIO 
receipts.  Uncleared deposits and receipts that cannot be explained by the delay in getting 
physical deposits to the bank should be researched and understood, and corrected if necessary. 
 

b) Look at the Trial Balance  report – especially look at files that are closed, that still retain funds – 
this may indicate duplicate receipts (which you will have been given a hint about by their being 
outstanding on the Uncleared Items  report). 
 

c) Review the adjustments that were entered into the reconciliation.  Determine what action needs 
to be taken with each (communication with the bank about a needed correction, or correcting 
receipt needed in a file, for example), and take the required action.  Keep a folder of outstanding 
and uncorrected adjustments, by account, with copies of related communications with each.  Use 
the contents of this folder to refresh your memory about each item during the next reconciliation 
cycle.  As things get resolved and the adjustments offset and cleared, keep the paperwork related 
to it with the report bundle for that reconciliation. 
 

d) Review the Uncleared Items report’s stale dated checks. 
 

Outside Service 

The Outside Service  menu item will initiate a routine that will load the uncleared receipts and 
disbursements within Impact, through the date identified for the reconciliation, and then the 
bank’s data will be matched against the data in the reconciliation.  If matches are found, by type 
and amount, then the items in the reconciliation are flagged as cleared.  Bank items that are not 
matched perfectly are noted on an Exception Report (imperfect matches as well as complete non-
matches). 

 
Above is the screen you will see if Outside Service  is selected.  You will pick the bank account  
to be reconciled, the location  of the bank download (you must save it to a drive you can access), 
the file name  of the bank download and the import filter  to be used.  Once these settings are 
selected for each bank, they are saved from one session to the next.   
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MISC. MENU 

The Misc. (ellanous) menu covers a broad range of functions, ranging from a quick way to view 
an escrow ledger (without having to go to the Impact Escrow module), to establishing new 
branches and/or banks in the system.  Savings accounts are managed from this menu, as is the 
Income Analysis data.  1099-S reporting is handled here.  Changing settings on files, relating to 
branch, escrow officer, processors and banks, is also addressed here.  Identifying printers to 
Impact and the generation of dynamic overdraft passwords, are functions that are called from this 
menu. Also, Accounting will be able to print a wire out audit report, an escrow HUD and Final 
Disbursement Report.  All of the functions will be explained in this section.  The options under the 
Misc . menu are: 
 

• Escrow & Savings Ledgers 
• Regular 
• Savings 

• Set Up & Print Savings Accounts 
• Edit 
• Print 

• Adjust Income Analysis  
• Modify 
• Print 

• 1099-S Reporting 
• Modify 
• Reports 
• Reporting 

• Set Up Branch 
• Set Up Bank 
• Change Branch ID of File 
• Change Escrow Officers 
• Change Processors 
• Change Banks 
• Printer Setup 
• Overdraft Passwords 

• Password Generator 
• Print Overdraft Authorization Log 

• Wire Out Audit Report 
• Print HUD 
• Print Final Disbursement Report 

Escrow & Savings Ledgers  

Regular Ledger 

There are many times when an Accounting user will need to see the full 
detail of an escrow &/or savings ledger.  The ledger is where all of the 
accounting transactions (receipts and disbursements) are presented 
(whether posted or in process).  When the request is made to display a 
ledger, of either type, the user will be prompted for the Escrow Number .  
Generally, you will have the Escrow Number  and will simply enter it and 
click on the OK button.  However, if you do not have the number, but you 

have a name (for example you have a funding check in hand, without an escrow number on it, but 
with a borrower’s name), you can use the Search  button to initiate a full system search of Impact.  
The search screen gives you many different ways to search the database, not just by name.  By 



Misc. Menu 
─────────────────────────────────────────────────────── 

─────────────────────────────────────────────────────── 
USA Digital Solutions, Inc. 
Accounting v5.12.0 Manual Page 68 of 98 5/30/2007 

entering the beginning of a last name, for example, and selecting the Both Names  radio button, 
and then clicking on the Search  button, you will get a listing returned of all files that have names 
of either the Borrower or the Seller which begin as you requested.  The more sure you are of the 
item being requested, enter a more compete description.  However, if at first you do not find what 
you believe you should have, limit the information you enter in the Search  For:  field.  You may 
also use the percent sign (%) as a wildcard in your searches.  It can be placed at the beginning, 
middle or end of your entry to tell the system to find anything that ends with what you entered, 
contains anything between your entry items, or begins with what you entered, respectively.  The 
search options are: 
 

• Both Names (Buyer & 
Seller) 

• Buyer’s Name 
• Seller’s Name 
• Property Address 
• Tax Parcel ID 
• Escrow Number 
• Base No. 
• Ref. No. 
• Subdivision (Name)  
• Loan Number (Lender) 

 
Once your search has brought back a listing of candidate items (the first 51 that meet the criteria 
will be presented), two buttons on the bottom of the screen will be enabled: Details  and More .  If 
you click on the Details  button, you will get property address information displayed in the lower 
left corner of the screen, for whichever item on the list is selected.  This is an on/off button, and 
will change to No Details  when first turned on.  The More  button will load the next 51 items that 
meet the criteria (if there are more than the initial 51 presented in the database).  As long as there 
are more items that meet the criteria, the More  button will be enabled. 
 
Once an escrow number is entered on the first screen presented above, or if a file is selected 
from the search results screen (with a double-click), the Regular Ledger  will be presented, as 
shown below.  General information about the file (Escrow Number, Escrow Officer, Branch, 
Bank currently assigned, and Buyer and Seller names) is presented on the top left of the screen, 
and summary accounting figures are presented on the top right.  The Posted Balance  is modified 
with the work in process  and on hold  to result in the Available Balance  – which is what is left in 
the file to be disbursed.  (The bank and amount fields, at the top of the sample screen below have 
been shaded over.) 

 
Note  that there are three tabs on this screen: Posted Items, Receipts in Process and 
Disbursements in Process.  Click on the tab heading to move from one to the other. 
 
The ledger presents, for each transaction, from left to right: 
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• The date of the transaction; they are presented in date order 
• The type (receipt or disbursement) and source (bank  account number); if 

the file has switched banks, you will see different  source numbers on some 
of the items. 

• Who entered the item (user’s initials) 
• The payor of a receipt or the payee on a disburseme nt 
• The receipt type (only on receipts) 
• The reference number of the item (receipt number or  check number); an 

“M” beside the check number denotes it was a manual ly prepared check; a 
“C” beside a check number indicates the check has b een cleared, through 
a reconciliations; an “H” will appear on a receipt that is on hold (remember: 
only Accounting can release non-current-date holds) , and a “V” will reflect 
a Void. 

• The amount (either in the receipts column or in the  disbursements column, 
as appropriate 

• And the running balance through each transaction  

 

Savings Ledger 

There are two or three buttons on the bottom of the screen: Print, Savings and Cancel .  If there 
is not a savings account affiliated with the file, the Savings  button will not appear.  You can click 
on the Savings  button to display the savings ledger – so you do not have to use the Misc. >  
Escrow & Savings Ledgers > Savings Ledger  path to get to the same place.  The Print  button 
will generate a hard copy of the ledger. 
 
When a savings ledger is requested, a listing of all of the savings accounts affiliated with the 
escrow is presented.  Select the account you wish a ledger for, and it will be presented.  A 
savings ledger is shown below. 
 
As all savings transactions are recorded with receipts or adjustments, those are the in process  
tabs presented, in addition to the Posted Items  tab.  You can click on the Print  button to 
generate a hard copy of the ledger.  Click on Cancel  to close the ledger screen. 
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Set up & Print Savings Accounts  

Edit 

The Edit  menu choice, under Set up and Print Savings Accounts , is used to add a savings 
account to an escrow or to modify information about an existing savings account (interest bearing 
account).  You can have an unlimited number of savings accounts assigned to an escrow, and a 
separate ledger is maintained per savings account.   
 
When selected, the Edit  function will display the same escrow file selection screen you see when 
you ask for a ledger, with the same search functionality available.  Hopefully, if you are adding a 
savings account, you know which escrow you are adding it to.  Upon selection of the escrow, you 
will be presented with this screen: 
 
The Print  function on this screen will 
provide a report of all of the savings 
accounts assigned to the selected 
escrow.  This report is similar to that 
generated under the Print  menu item, 
but that report can include information 
on more than one escrow. 
 
To add a savings account to the 
selected escrow, click on the New 
button.  To edit an existing account’s 
information, select the account and click on the Modify  button.  You will be presented with the 
same screen, with either choice.  A sample is shown here.  The screen will be blank if you are 
entering a new account, or the fields will be populated if you are modifying the information on an 
account.  The Delete  button, on the account listing screen, is used to delete an account entered 
in error, or which was not used.  Once an account has activity, it cannot be deleted. 
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The information maintained here is: 

• Account Number 
• Bank Name 
• Date Opened 
• Date Closed 
• Social Security Number (Account Holders) 
• Name of the Account Holder 
• Address of the Account Holder 
• Location (City, St) of the Account Holder 

 
 
 
 

Print 

Information about savings accounts for a particular escrow, accounts at any one or all branches 
or about all accounts by bank is generated with this function.  You have the option to include zero 
balance accounts, as well as whether to include just open accounts, just closed or both. 

 
This is a sample layout of the Savings Account Listing, by Branch Number .  The report 
presents, from left to right: the Escrow Number , the bank Account Number , the Bank Name , 
the Open Date of the account, the Close Date , the Last Transaction Date , the Account 
Balance and the information about the owner of the account (name and address) .  The report 
always presents the current, posted account balances. 
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Adjust Income Analysis 

Modify 

The tracking of fee income is very important to a title and/or escrow company.  Impact provides 
for the generation of fee checks, or fee slips.  Regardless of which form of transaction is used, the 
fee check/slip can be coded with “income codes” – which can be set up to mirror the accounting 
codes (G/L) used by Financial Accounting for the revenue streams generated by the company 
(escrow, title, tracking, delivery, bank fees, etc.).   
 
Only disbursements that are generated with the :T  or :E (read: colon “T” or colon “E”) payee are 
able to be coded with income codes, and only coded items appear in the Income Analysis File.  
This is very important.  In order for the fee checks/slips to match up with the amount in the 
Income Analysis File, all lines on the fee checks/slips must be coded.  There is a system setting 
that can be turned on to mandate that all line items be coded on a :T or :E fee check/slip before 
the disbursement will be accepted. 
 
Note while the generation of these disbursements is done via the Escrow module the 
maintenance and reporting of them is done in the Accounting module.   
 
The Modify  function is used to correct income codes or amounts on fee check/slip line items, 
after they appear in the Income Analysis File, through the daily posting routine.  When the 
function is initiated, you will be prompted for the branch involved and a start date (all items from 
that date forward to the latest posting date will display).  Once both fields are filled, hit the OK 
button to begin the selection of items, and a screen like this will be presented: 
 

 
Note that there may be several lines presented for each check; there is one record per HUD line 
involved in the generation of the disbursement, therefore there may be two or more lines for title 
fees, for example, if there is a fee for both a lender’s policy and owner’s policy collected.   
 
To change a record, click on it so it is selected, and then click 
on the Modify  button, and a screen will be presented with all 
of the data for the one item selected (sample shown). 
 
You can change all of the information on this screen.  The 
changes will be saved if you click on the OK button, or lost if 
you click on Cancel . 
 
Changes made here are not  reflected in the original ledger or, 
if it is being used, the Overhead Fee Account  (see below).  
Currently, the system will permit editing of individual lines, 
without regard to the original total of the disbursement check 
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or fee slip.  Therefore, the user must be very careful  when adjusting any dollar figures, to ensure 
that the adjusted figures on the individual records of a check still add up to the original total for 
the check.  This must be done to prevent too much or too little from being transferred from the 
escrow account to the operating account.   
 
Note:  A system configuration setting can be turned on that will only allow Accounting to edit the 
income code but not the amount to eliminate this risk. 
 

Print 

This function is used to generate reports of the information in the Income Analysis File .  Usually, 
these reports are used to document or detail the fees being transferred from the escrow account 
to the operating account.  If fee checks are being used, these reports still have value, as they 
provide a consolidated presentation of all coded fee items.  Remember, only items with the :T or 
:E payee (colon “T” or “E”) and which are coded will appear in the Income Analysis File , and, 
therefore, on these reports. 
 
You have the choice of generating a summary or detail report, for any date range up to and 
including the last posting date.  The report layouts are usually the same.  On the Detailed 
Report , all fee checks/slips are presented, with totals by Branch (and Bank, if so designed).  The 
Summary Report  simply presents totals by Branch (and Bank, if so designed).  The columns 
present the various fee codes in use at the company.  This report is customized, for the income 
codes, for each company.  A sample of the detailed report is shown here. 
 
 

 

Overhead Fee Accounts 

Accounting has the ability to utilize Overhead Fee Accounts  (one per bank account) when the 
company is using fee slips.  The system configuration under the Escrow tab must be set to use 
transfer slips  in lieu of a revenue check . The system configuration under the accounting setup 
options must have the enable Overhead Fee Account  checked.  The Overhead Fee Account  
“number” must be established in the escrow module, assigned to the appropriate bank, assigned 
to branch 999, and must be added to the Bank setup information. 
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When escrow disburses the revenue, creating a transfer fee slip , Impact will automatically 
create a receipt batch for branch 999 and credit the revenue amount to the Overhead Fee  
Account  number.  Receipts automatically created for the Overhead Fee Account  may not be 
modified. The Daily Analysis  will produce a listing for branch 999 showing the amount being 
credited to the Overhead Fee Account .  After the daily posting, the Overhead Fee Account  will 
have a posted balance. The receipt type will be designated as “FST” and the receipt will show the 
originating escrow file producing the revenue. 
 
Accounting may then transfer the funds to the general operating account, either by check, or wire-
out.  The breakdown to support this transfer would be provided by the Income Analysis  report 
discussed above. 

1099-S Reporting – General Discussion 

The Internal Revenue Service (IRS) requires that the transfer agent (the escrow company) file a 
report on many transfers of real estate (a 1099-S).  While the rules and exemptions will not be 
explained here, the functionality built into Impact will be.  The escrow officers should complete 
and distribute the 1099-S forms at the time of closing.  The Closing Report  is run (by Escrow) to 
confirm that all items are marked non-reportable or reported.  The 1099-S Report  is run (by 
Accounting) to review the data that will actually be submitted; modifications of the data are made 
as needed; and, the data is reported to the IRS after the end of the calendar year. 
 
The generation of 1099-S forms is handled in Impact Escrow.  If a 1099-S is required for the 
transaction, the escrow officer must enter some data into Impact, and the 1099-S form is 
generated at closing and provided to the seller.  At the start of a new year, the company is 
responsible for filing, with the IRS, information about all of the 1099-S forms issued during the 
prior year.  The functionality for reviewing the readiness of this data is split between this portion of 
the Accounting module and with a report out of the Escrow module.  The generation of the filing 
for the IRS is managed in the Accounting module, through this menu area.  DSI can also conduct 
the filing of 1099-S information with the IRS on behalf of your company, if so desired.  Please 
discuss this with your DSI representative. 
 
There is an added twist to the IRS reporting when you have a non-US citizen seller, and the 
transfer meets certain conditions.  That IRS reporting (Form 8288 et al ) is not managed through 
Impact, but there is a flag that the escrow officer can set if there is a foreign seller involved in the 
transaction.  There is a report that Accounting can run, on foreign seller transactions specifically, 
to assist in the follow-up on the reporting requirements.  As there is a tighter timetable involved in 
this reporting (20 days after closing), and so this report should be reviewed frequently. 
 
 
 
 
 
There are three menu items under 1099-S Reporting : 
 

1. Modify 
2. Reports 
3. Reporting 

 
The first two items will be used throughout the year, for monitoring the development of the data 
set that will be reported to the IRS, and the third item provides for the generation of the actual 
data file for the IRS.  Each will be explained in detail below. 
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1099-S Reporting 

Modify, Print, New, and Delete 

The first item on the 1099-S Reporting  menu is the Modify  function.  However, Accounting users 
will more than likely begin the verification effort, of 1099-S data, with the Reports  function (which 
is explained below).  Regardless, at some point you may need to modify existing 1099-S data for 
a particular file.  In addition, you can re-print a previously completed, or newly modified, 1099-S 
from this menu item.  You may also delete a 1099-S prepared in error, or add a new 1099-S. 
 
When selected, you will be presented with the standard Select Escrow  screen, with the search  
function available.  Enter the escrow number for the 1099-S you wish to re-print , modify , add  or 
delete .   
 
A list box (shown below) will be presented of all 1099-S’s that have been prepared for the escrow.  
Click on the item to be printed, modified or deleted, and click on the appropriate button.  If you 
need to add a 1099-S, click on the New button.  Click on the Cancel  button to close the screen. 
 
Clicking on the New or Modify  buttons will take you to a screen containing fields of required data 
for the 1099-S.  If you called for a new 1099-S, the fields will be blank.  You must enter the 
required information.  If you modify a 1099-S, the fields will contain the data presently stored in 
the system. 
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The fields are:  
• Date Closed : self-explanatory. 
• Date Recorded : self-explanatory. 
• Branch : self-explanatory. 
• Escrow Officer : self-explanatory. 
• Sales Price : the amount applicable to 

the individual whose tax ID number is 
on this 1099-S.  This is likely not the full 
sales price, if there is more than one 
1099-S being done for the transfer. 

• Property Tax : HUD lines 107-407, or 
worksheet county taxes credited to the 
seller, the amount will appear here.  

• Individual : Click on this box if the 
transferor is an individual, and the tax 
ID number that will be entered in the ‘SSN’ field is truly the Social Security number (SSN) 
of the individual named. 

• Corporation : Click on this box if the transferor is anything other than an individual, and 
the tax ID number that will be entered in the ‘SSN’ field is really an Employer ID number 
(EIN).  Note: this may be an EIN of a trust, partnership, LLC or corporation.  While the 
field is called ‘Corporation’, it really means “not an individual”, and triggers a different 
treatment of the contents of the  ‘Name’ field when data is reported. 

• Exchange : While this check box is grouped with ‘Individual’ and ‘Corporation’, it is 
unrelated to those items.  Checking this box will mark the corresponding box on the 
1099-S. 

• Foreign Alien : If your seller is not a US citizen, check this box.  Data on the transaction 
will be reported to the IRS, without a Social Security number.  Please determine if the 
transaction must be reported under the Form 8288 process. 

• SSN: Enter the tax ID (Social Security number OR Employer ID number) in this field, with 
the proper hyphenation.  An SSN is in the form ###-##-####.  All other tax ID numbers 
(for trusts, partnerships, LLC’s or corporations) are in the form ##-#######. 

• Name: If the transferor is an individual, enter the last name first, followed by a comma 
and then the first name.  In all other cases, enter the name of the transferor without 
rearranging it; as it is known to the IRS (from the assignment of the EIN). 

• Foreign Address : This check box will switch the address fields from asking for a US 
state and zip code, to a form that does not ask for those entries.  

• Address fields : Enter the mailing address of the transferor. 
• Property Address  fields: Enter the physical address of the transferred property, and the 

county of the transferred property. 

Reports 

The Reports  function is used, in conjunction with the Closing Report  (out of Escrow), to facilitate 
the “scrubbing” of data before it is sent to the IRS – to cut down on the number of errors reported 
back from the IRS, each with a $50 penalty assessment.   
 
Before running the report from this module, the Closing Report  should be run out of the Impact 
Escrow module.  The right hand column of that report reports on the 1099-S status of each file.  If 
the file is marked Non-reportable , that will be indicated.  If the file has had one or more 1099-S’s 
prepared, and they are complete, the column will reflect Reported .  If a file is not flagged Non-
reportable  and one or more 1099-S’s have not been prepared, the field will reflect Unknown .  
These files should be properly completed, before the 1099-S report is run out of Accounting.  If 
the file has not been properly completed, there will be nothing to check on the Accounting report. 
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You can run the report sorted by Escrow Number, Social Security Number (tax ID numbe r), 
Escrow Officer or by Branch  (one or all).  Your choice will be dependent on your company’s 
policies and procedures regarding who will scrub 1099-S data.   

 
To generate the routine report for scrubbing, select the Regular Report .  For a report of just 
those items flagged as Foreign Alien , check that box. 
 
A date range is entered.  If routine scrubbing is being done throughout the year, this may be for 
one month, but a full year report should be run after year-end to re-check everything in the file, 
before it is transmitted to the IRS.  Once the data has been scrubbed, you may wish to re-run a 
full year report so you have a hard copy of what will be submitted to the IRS.  The report layout is 
displayed below.  You will need to review the report for missing data or for improper name entries 
(not ‘last name first’, for entries with a true SSN), and for obvious typos.  
 
 

 
 

Reporting 

1099-S data must be reported to the IRS annually.  The data must be reported to the IRS 
electronically (upload via Internet connection) for Tax Year 2006 and on.  The IRS has specific 
record layouts required for this reporting.  This function provides for the generation of the file 
required.  You can generate a test file, which will not flag the data as having been transmitted, but 
will provide you with a file to see what it looks like, and to confirm the process is working properly.  
You may also generate a replacement file, if the IRS has requested it. 
 
Select the IRS reporting entity you will be reporting for.  If you are using alternate company 
names for your branches, you may have multiple reporting entities.  In that case you will create 
multiple files to send to the IRS. 
 
Enter the date range for the file.  Typically, this will be January 1st through December 31st for the 
year just ended.   
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Identify where the file to be generated is to be stored.  To do an electronic filing, you will likely 
store the file on your PC or server and then upload it to the IRS (follow the instructions provided 
by the IRS for electronic filing, Publication 1220 located on the on the IRS website www.IRS.gov).  
Also see the Impact IRS Form 1099-S Electronic Filing Guide . 
 
When you click OK the system will prepare the appropriate file to disk or diskette, and will  
produce some reporting to the printer.  If you did not select Electronic Filing , (which you should  
as magnetic filing on diskette is not permitted for tax year 2006 and beyond) you will receive a  
 
Form 4804 – Transmittal of Information Returns Repo rted Magnetically , in addition to an IRS 
Reporting Information Sheet  that presents summary totals of the number of returns in the file 
that was generated, and a Foreign Alien  report – both of which will print in either case. 
 
The current filing deadline is March 31, for electronic filing. 
 

 

Set Up Branch  

The Set up Branch  function, under Misc. , provides for the entry of new branches into the 
system, and for the editing of settings for an existing branch.  This module is exactly the same as 
that found in the Impact Utilities module> System Files > Branch .  Generally, the function in 
Utilities would be used by the system administrator or DSI, when setting up the system the first 
time, and then Accounting staff would use the function within Accounting on an on-going basis.   
 
Important notes:   

• The original Title office is always assigned the br anch number ‘099’ (not ‘99’, but 
‘099’). 

• The Accounting Department (Escrow Accounting, not F inancial) is always 
assigned the branch number ‘999’. 

• The branch number ‘998’ is reserved for a “Training  Branch”. 
• ALL bank accounts must be assigned to branch ‘999’ (Accounting), in addition to 

the branch(s) that use them. 
 
When the function is selected, a “Branch File” screen is displayed, presenting the branches that 
have already been set up in Impact.  The branch number, name and street address are 
presented, along with Print, New, Modify, Delete  and Cancel  buttons.   
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Print 

The Print  button will generate a report of all of the branches defined in the branch file.  The report 
will present the branches’ numbers, full addresses, phone and fax numbers, counties, as well as 
banks assigned to each branch.   
 
It is recommended that the branch report be printed out routinely, and reviewed for accuracy. 

New 

The New button will bring up a blank form, into which you will enter information about a new 
branch.  There are four tabs across the top of the screen, representing four screens of 
information about each branch.  The settings established on these screens are very important 
and should be done with care.  The four screens are: Branch Information, Bank Information , 
Savings Information  and Title Departments  (only shown for Escrow branches if the option for 
multiple Title Departments is set in the Utilities Setup Options).  Each of these will be discussed in 
detail below. 
 
The Branch Information  screen (shown below), is the first screen presented, and is where the 
basic information about each operating unit is established.  While it is called “branch” information, 
Title and Accounting units are also established as “branches”.  Generally, a training branch (998) 
will also be set up, by DSI, to facilitate that effort. 
 

 
 
The first field on the screen identifies the Branch Type .  There are three types of offices: Escrow, 
Title and Other.  Use the drop-down to select the type being established. 
 

• Escrow  – this type would be assigned to normal escrow branches and to the Accounting “999” 
office, and provides for the routine escrow functionality within Impact.  This setting permits 
receipts and disbursements to be generated under the number established for the office, in 
addition to income tracking.  The “Accounting” office is set up as an “escrow” office. 

• Title  – this type should be assigned to pure title offices; no receipts or disbursements are 
permitted under the branch number.  Note:  if a Title Department is going to generate receipts 
and track income, then establish a separate “escrow”-type branch for this purpose.  Sub-escrows 
need to be established under an “escrow” branch. 
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• Other  – if an office is being set up as a “control branch”, it should be designated with the “other” 
type.  A “control branch” is one established solely for the purpose of managing the check, receipt, 
deposit and wire-out numbers issued across a range of branches, when the numbers are not 
assigned across all branches using the same bank. 

The Branch Number  is established next.  The number is three positions long, zero-filled from the 
left, if less than three non-zero numbers.  Note: the number “099” is reserved for the primary Title 
unit, and the number “999” is reserved for the Accounting unit.  As noted above, “998” is generally 
also used, as the “Training Branch”.  Therefore, there are 996 office numbers available for use, at 
a maximum. 
 
The Name of the office should be accurate and descriptive.  It is the identifier that will appear on 
most reports, and may or may not appear with the branch number.  The names should be unique; 
to prevent confusion in cases where the number is not presented. 
 
The Address  information is for the physical location of the branch, and will appear on letterhead 
documents – so do not use the same address for all branches, unless they really are in the same 
location.  The phone and fax numbers should also be for the specific office. 
 
The Manager’s Initials  field should only be filled in if all escrows opened in the office should be 
assigned to one escrow officer.  The initials should be a valid set of user initials, as set up in the 
Password  File.   
 
The name entered into the County  field will be the default value loaded into the county field in 
each escrow file opened under the branch number being established.  It can be changed, in each 
escrow file, if need be.  The thinking here is that most transactions opened by an office will relate 
to properties from the surrounding area.  If that is not the case, then the county entered should be 
that from which most files originate, or can be left blank. 
 
The Last EOM (End-of-Month) Date  is identified to specify the “as-of date” for the EOM Balance  
data on the Bank Information  and Savings Information  screens.  This is the starting date from 
which Impact will aggregate data, at each posting, until the Close Month  function is performed, 
rolling the new end-of-month figure up to be the new starting figure for the next month’s 
aggregations.   
 
If the Use Alternate Company Name  box is checked, a field will be presented next to it in which 
to enter another company name, to be used on letterhead and other documents for this specific 
branch, rather than the name established for the database-wide company (through System 
Files> Xref .). 
 
The Default Underwriter  for the office is selected near the bottom of the screen.  If an 
underwriter is selected here, it will automatically be loaded in the Initial Questions  area, after an 
escrow file is opened.  The default underwriter can be changed before the order is sent to Title 
from Escrow.  If “0-None” is selected on the Branch Information  screen, then the default 
underwriter established under System Files> Setup Options> General  will be loaded into the 
Initial Questions area.  The underwriters are set up in the Impact Title module, under 
Documents> Document Maintenance> Edit Underwriter M enu Table . 
 
The IRS Reporting Entity  for the office is selected near the bottom of the screen.  If you are 
using an alternate name, you might also have a separate IRS Reporting Entity.  This is the name 
and tax ID number that appears on the 1099-S forms.  If you have multiple IRS reporting entities, 
then you will generate a separate file under 1099-S reporting for the IRS. 
 
The Branch Active  Yes/No radio button is used to “turn off” a branch, if it is closed, merged with 
another or sold, for example.  The “No” setting will prevent users from creating new escrows 
within the branch, but will not prevent users form working files that have already been opened in 
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the branch.  Reconciliations can continue to be done that involve transactions originated at the 
“turned off” branch.  This toggle also permits the system administrator to set up branches in 
advance of their “go live” date (by creating them, but making this setting “No”) and then switching 
them on at the appropriate time. 

Bank Information 

The second tab of branch information relates to the bank account(s) used by the branch and the 
numbering sequences to be used for checks, receipts, deposits and wires out for each 
branch/bank account combination.  On an on-going basis, this screen (shown below) will also 
present the aggregate month-to-date accounting balances for each branch/bank account 
combination.   
 
Before a bank account can be related to a branch, the bank account must be established within 
Impact.  This can be done in Utilities> System Files> Banks> New  or Accounting> Misc.> Set 
Up Bank > New .  The assumption will be made here that the bank has already been set up. 
 
To relate a bank account to a branch, click on the Add  button, under the Banks  assigned to (###) 
branch name  section of the screen.  A listing of candidate bank accounts will be presented.  
Select the desired bank account, from the list presented, by clicking on it and clicking OK.  If you 
clicked on Add  in error, click on Cancel  on the Banks  screen to return to this screen.   

Any number of accounts may be assigned to a branch. 

Note:   all bank accounts should be assigned to the Accounting “999” branch 

 

 

 

Normally, one bank is tagged as the Default bank for this branch , with the check box of that 
name.  
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Once a bank has been related to a branch, the next step is to assign starting numbers for the 
numbering of Checks, Receipts, Deposits and Wires out .  To enable edits in the number 
assignment area, and to see current running totals, a bank must be highlighted in the Banks 
assigned to…  area, and the Modify  button clicked. 

There are three options for governing how numbers are assigned to these items: by branch, by 
bank or by a check control branch.  The radio buttons indicate your selection.  

Beginning with Checks , the first tab in this section, the alternatives are: 

 

• By Branch : this selection is most appropriate if you have separate accounts for each branch, but 
the By Bank  option will serve in that instance as well.  This option is a holdover from the time 
when Impact was designed for “remote-main” processing and it was more difficult to share 
information across the full company.  With the use of a SQL database, this problem is gone, and 
the need for a “by branch” option is minimized…but it is still available.  Should your company be 
using pre-numbered checks, you may still want to use this option.  Great care should be taken, if 
multiple branches are using one account, and you want each branch to have unique sequence 
number ranges, to space your starting check numbers sufficiently apart, from branch to branch, to 
prevent one branch from “running into” another.  If this selection is made, enter one less than the 
starting number in the field to the right of this radio button.  As the account is used (checks are 
issued), the number that appears in this field will increment up.   

 

NOTE: while the field for check number can hold up to 15 digits many banks are limited to 12 
digits (or less) for their check numbers.  Confirm your bank’s limit before determining the 
numbering scheme for your company. 

 

• By Bank : this is the most common setting, in the SQL environment, with laser printers using 
MICR toner generating checks on blank check stock.  Whether you have separate accounts for 
each branch or not, using this setting will govern the administration of check numbers across all 
offices that are using each account.  If this selection is made, the starting number entered in the 
field to the right of the radio button should be the same for all offices that will be using the 
account.  This field will reflect the last check number used. 

• By Check Control Branch : this option should be selected ONLY if you are using one account for 
multiple branch numbers AND have other branches, also sharing the account, which will have 
unique sequences assigned to them.  In this situation, you cannot use the “by bank” option, as 
not all of the sharing units are to be pulling the next available number from a single point.  This is 
most applicable to physical locations that may have multiple operating units (‘branches’) within 
them, and which are using pre-numbered checks, and where not all of the branches are to pull 
from the same starting number.  For those offices that are sharing a number sequence, select the 
control branch option. Rather than entering a starting number under this option, you will enter a 
branch number: the check control branch.  The check control branch  will need to have already 
been set up, and, within its configuration, the bank account will have been selected, with the by 
branch  option and a starting check number.  This can be a “real” branch, it need not be a 
“dummy” branch number.  You can use the branch number of one of the “sharing” units as the 
control branch. 

The Receipts tab is identical in presentation.  The considerations in assigning numbers to 
receipts are also similar, and the By Bank  option is common, and recommended in most 
instances, as this prevents the chance of duplicate numbers being assigned to receipts.  It also 
permits a Receipts Journal  to be run by bank so missing receipts can easily be identified (when 
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troubleshooting issues).  Some companies wish to tag their receipt numbers with the branch 
number in the leading digits (for example: “0562000000000001”, for branch 562’s first receipt), to 
help the Accounting staff be able to rapidly identify the branch responsible for a receipt.  In this 
instance, you would need to use the “by branch” or “by check control branch” options.  As each 
company’s environment is unique, how the numbers are assigned is left to each company – but 
should be carefully considered. 
 
The Deposits tab is also identical in presentation, and the considerations are similar to receipts.  
The By Bank  option is recommended in most instances. 
 
The Wire Out tab, again, is similar.  Wires out are considered disbursements in Impact.  Again, 
the By Bank  option is recommended in most instances.  Wires out are numbered regardless of 
whether the Wire Out Processing feature is in use or not. 
 
The month-to-date aggregate information, shown in the bottom left of the bank information screen 
once an account has been highlighted, and the Modify  button clicked on, is of use when 
troubleshooting issues.  As daily posting is done, the “buckets” are incremented up by the total 
amount for each type of transaction for the branch/bank account combination.  When the Close 
Month  function is run, the final Current Balance  will be moved up to the EOM Balance  and the 
other buckets will be cleared out, in anticipation of the new month’s data coming in.  The Current 
Balance  should match your Trial Balance  total for the branch/bank account.  On rare occasion, 
these figures might need to be altered – but that should only be done under DSI direction. 
 

Savings Information 

The screen under the tab Savings Information  presents the aggregate month-to-date totals of 
savings activity for the selected branch.  When creating a new branch, these figures will be zero, 
and nothing need be done on this screen – unless a starting balance is required when switching 
from another system to Impact.  The Current Balance  should reflect the total of the Savings 
Trial  Balance  as of the current posting date.  The savings balance is a total of all savings 
accounts assigned to the escrow file.  An escrow file may have unlimited savings accounts. 

 

Title Departments 

Impact can be configured to permit more than one Title Department to be made available to the 
branches.  However, at least one title “branch” must be set up before branches can have it 
assigned to them.   If more than one title branch is set up, the Title Department  screen will be 
made available.  A branch designated as a “Title” branch, will not have the Title Departments  tab 
presented in the “Branch” configuration module. 
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The Title Departments  tab presents a listing of the previously selected title units available for 
use by the branch being configured – this will be blank for a new branch set up.  There are Add  
and Delete  buttons on the screen (hidden in the example shown).  Clicking on the Add  button will 
bring up a window from which you will select a title unit (as shown here).  Highlight the desired 
title unit, and click on the OK button.  Repeat, if there is more than one title unit available in the 
database, and you wish more than one to be available to the branch in question.  Click on Cancel  
to indicate you are finished with selecting title units for the branch. 
 
Once one or more title units are assigned to a branch, they will be visible within the Escrow 
module, with regard to where a title order should be directed. 
 

 
Note :  If the option for multiple Title Branches is enabled then each Escrow Branch under Setup 
Branch must have a Title Branch or Title Branches assigned to it. 

Modify 

The Modify  button, when hit after a branch is highlighted, will present the user with the same set 
of screens discussed above, under Misc.> Set Up Branch> New , but now there will be data in 
the fields.  This function is used to update branch configurations and to view the month-to-date 
figures for each branch/bank account.  
 
Care should be taken when changing some settings (such as how check and other transaction 
type numbers are assigned) once they have been in use.    
 
The Branch Active  Yes/No radio button is used to “turn off” a branch, if it is closed, merged with 
another or sold, for example.  The “No” setting will prevent users from creating new escrows 
within the branch, but will not prevent users form working files that have already been opened in 
the branch.  Reconciliations can continue to be done that involve transactions originated at the 
“turned off” branch.   

Delete 

The Delete  button will only be effective if no activity has occurred with a branch that had 
previously been configured (if it was set up in error, for example).  Once a branch has activity, it 
cannot be deleted. 

Cancel 

The Cancel  button closes the Branch  function, and returns the user to the main Accounting  
screen. 
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Set Up Bank  

The Set Up Bank  function, under Misc. , provides for the entry of new bank accounts into the 
system, and for the editing of settings for existing bank accounts.  Depending on your password 
authorization level this function may or may not be available.   This module is exactly the same as  

 
that found in the Impact Utilities module, under System Files> Banks .  Generally, the system 
administrator or DSI, when setting up the system the first time would use the function in Utilities, 
and then Accounting staff would use the function within Accounting on an on-going basis.   
 
 
NOTE #1: When a new bank account is established, DSI must create the laser check and laser 
deposit slip report files.  Please give DSI as much advance notice as possible of plans for utilizing 
a new account.  
 
NOTE #2: The bank’s specifications for its reconciliation export and positive pay import files must 
also be forwarded to Digital Solutions, so we can confirm that the filter programs already in 
existence will work properly, or create new filter programs as needed (at least if you intend to use 
a bank download in the reconciliation process, and intend to upload check issue data to the bank 
for positive pay processing). 
 

When the function is selected, a Bank  screen is displayed, presenting the bank accounts that 
have already been set up in Impact.  Within Impact, the word “bank” is used to mean “bank 
account”.  Every escrow trust bank account will be assigned a separate bank number within 
Impact, even if at the same financial institution.   

Note:   Once a bank account has been established it must always be assigned to the Accounting 
branch “999” and to each branch that will be using the account. 

New 

To add a bank account into Impact, the New button is clicked, and the screen above is presented.  
Note that the next sequential bank number is automatically selected as the next number to be 
used.  You may not change this selection.  If multiple bank numbers have been established and 
one was deleted then Impact will use the first available sequential number for the bank 
assignment. 
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When a bank account is initially set up, you may wish to make it inactive (Bank Active : No radio 
button), until the real “go live” date is reached.  Then, at the time you wish to make the bank 
account available to users, you will click on the Bank Active : Yes radio button. 
 
The name of the financial institution , and its address are entered in their respective fields.   
 
The account number  is entered into its field.  Note: if bank downloads are used with the 
reconciliation process (with the Outside Services  function), the account number entered here 
should be in the same format as seen in the bank download.  You do not have to worry about this 
initially, but if the import in the reconciliation fails, with a message that the “File Format is Invalid”, 
you may need to change the account number here.  For example, the bank export may have a 
number of leading zeros before the account number that would need to be entered here.  This 
field can be altered without impacting checks (they do not get their number from this field). 
 
The Last Statement Date  and Last Statement Balance  fields are used by the reconciliation 
module as starting figures. 
 
The Overhead Fee Escrow Number  is used if the system is configured to use overhead fee 
accounts (System Files> Setup Options> Accounting> Enable Ove rhead Fee Account ).  If so 
configured, this is the escrow file into which the company’s fees (:T & :E  payees) would be 
automatically transferred to upon disbursal at closings.  The fees can then be taken, en masse, 
from this escrow on a periodic basis (daily is recommended).  A separate escrow file per bank 
account must be set up, and the number of the escrow is entered in this field.  The overhead fee 
escrows should be set up under the Accounting branch “999”. 
 
The Max Length of Other Wire Reference  is used to give the user a field long enough to 
elaborate if necessary on the wire out form.  This is only available if you are using Impact’s wire 
out feature, where Accounting confirms the wire out with a bank tracking number. 
 
The Cutoff Time  is just for printing on the wire out form.  It provides notification to the user that 
their accounting department will not transmit wires after the cutoff time. This will not inhibit the 
user from entering a wire out after the cutoff time. 
 
Click on OK to save your entries, or Cancel  to close the form without saving your entries.  You 
will return to the Banks  table, from where you can add another bank account, modify an existing 
bank account or delete an unused bank account.  A report of all of the account information in the 
table can also be printed.  The Cancel  button, on the Banks  listing screen, will return you to the 
main Utilities  screen. 

Modify 

To view the detail on an existing bank account, or to change the existing information, highlight an 
account on the Banks  listing and click on the Modify  button.  The same screen shown above, 
under the New discussion, will be presented, but with the fields filled with the previously entered 
data.  The current (last reconciled) bank statement date and balance will be in their respective 
fields.   
 
You cannot change the bank number. 
 
You can change the bank’s active status – if you are “turning on” an account or “turning off” an 
account.  If a bank account that has activity against it is made inactive, no new escrows will be 
permitted to be assigned to the bank, but existing files with balances may continue to be worked 
off, and postings and reconciliations will continue to post to the account. 
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You can change the bank’s name and address information and, if needed to accommodate a 
bank export reconciliation file, you can change the account number’s number of leading zeros or 
punctuation (see the discussion above under New). 
 
Click on OK to save your entries, or Cancel  to close the form without saving your entries.  

Delete 

The Delete  button will only delete the highlighted bank account if there has been no activity 
related to it; no receipts, checks, wires out, and no escrows assigned to it.  If a bank account 
were set up in anticipation of use, but then was not, it can be deleted. 

Print 

The Print  button will generate a report of all of the bank account information, sorted by bank 
number. 

Cancel 

The Cancel  button will return you to the main Accounting  screen. 

Change Branch ID of File 

There are times when one or more files need to be reassigned from one branch number to 
another.  An escrow officer may move from one branch to another, a client on a specific file may 
wish to use an escrow officer in another office, or an officer may leave and his/her files might be 
reassigned, in whole or in part, to an officer at another branch. 
 
Note:   If the two branches involved in the switch have different bank accounts all data must be 
posted current before a switch is made.   
 
The Change Branch ID of File  selection provides for three versions of branch number 
reassignment: a single file’s assignment can be changed; all files within one branch can be 
switched to another branch number; or, all files assigned to one escrow officer (within one office) 
can be switched to another office (and, simultaneously, to a specific escrow officer, if desired). 
Impact also has the feature to switch posted and unposted income to the new escrow officer, if 
you want to change the escrow officer on branch transfers.  As this is a very powerful function, 
with potentially big ramifications, care should be taken in its use.  It is strongly recommended that 
“before and after” reports (Trial Balance and Income Analysis) be run to confirm that the 
requested action had the desired result. 
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Change Escrow Officers 

There may be an occasion when all of the files assigned to one escrow officer in a branch need to 
be reassigned to another escrow officer (if an escrow officer leaves, for example).  The Change  
Escrow Officers  function is used to reassign all files within the office currently assigned to the 
escrow officer to another escrow officer in the same office. 
 
You have several options available when changing an escrow officer on a file.  Apply to all files  
will change ALL files (closed and open), so all history under the old escrow officer number will be 
eliminated.  Also you may change the income assignment which will also eliminate all previous 
income assigned to the original escrow officer. You may wish to leave the old assignments in 
place, and just use the new escrow officer’s initials on new files. 
 
Apply to open files only  will leave closed and cancelled files attached to the original escrow 
officer.  This is good for historical reporting data.  This selection will also retain the original escrow 
officer on posted income. 
 
Apply to closed files with balances  will only change the escrow officer, if the escrow has a 
closed date and funds are showing on a Trial Balance. 
 

 

Change Processors 

The Change Processors  function is much the same as the Change Escrow Officers  task, but 
changes the processor assignments from one to another.  The processor might be the escrow 
assistant, secretary or a central processing individual.  This assignment is originally made in the 
Escrow module>Edit> Initial Questions . 
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Change Banks  

 
The change banks  screen gives you the option of specifying one specific file number or all files 
in a specific branch or all files in all branches.  Depending on your password authorization level 
this function may or may not be available. To change the bank on one specific file number select 
the radio button specific file number  and enter your escrow number in the field.  Then select the 
original bank number from the available banks and the new bank number.  Press OK to continue.  
Receipt entries will be created showing a debit out of the old bank and a credit into the new bank.  
The original source bank on existing transactions are NOT changed. 
 
If you select All Files in Branch Number  option, this function is used to create receipt entries 
that move the posted balance on all files in an office assigned to one bank to another bank, also 
assigned to that office.  The bank assignment on the escrow is then changed.  Note, however, 
that the bank numbers on existing transactions are NOT changed – which will come into play 
when voids of original bank items are done. 
 
Note:  before using the change banks function, all posting must be up to date.  There can be 
NO “in-process” items. 
 

Note:  Accounting must remember to move the funds between the actual bank accounts. 

 

Before initiating Change Banks , for all files, Accounting should run a Trial Balance  on the 
original bank account for the branch involved; after changing banks, the new bank account’s Trial 
Balance , for the branch, should equal the original bank account’s Trial Balance , for the branch, 
and the original bank’s Trial Balance , for the branch, should be zero. 

 
Note: changing banks does not change the bank on any outstanding checks.   

 

If a check needs to be voided in an escrow that has switched banks, where the original bank is 
shown on the outstanding check, the routine voiding process should be used.  Impact will create 
receipts automatically to reflect the movement of the funds between the old bank and the new 
bank.  Accounting will need to move the funds at the bank. 

Printer Setup 

Each installation is unique in the printers it has at its disposal and how they are configured.  Once 
printers are established within the computer environment (either in Citrix sessions, or in a terminal 
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server environment, or locally), Impact must be told which printers to use for each user.  
Depending on the user, Impact will need a document printer defined (at a minimum) and, 
possibly, a check printer will need to be defined.  Note that the check printer is distinguished by 
the fact that it uses MICR toner, so banks’ proof machines can recognize the encoded information 
on checks and deposit slips. 

This function is available in the Impact Escrow, Title, and Utilities module, as well as in 
Accounting.  The configuration only needs to be done once for each user. 

 

Two tabs are presented, one for the document/report printer  and the other for the check 
printer .  Simply select the printer to assign to each task, and set the letter and legal paper 
sources to auto select , unless a specific tray assignment is mandated by your environment.  No 
paper source is made for the check printer, as all check stock will be of one size. 

 

When print jobs are queued up, Impact will 
know whether it needs the check printer or 
the document printer, and will send the jobs 
to the correct printers. 

 

 

 

Overdraft Passwords 

Overdrafts can be prevented, until a dynamic overdraft password is provided to an Escrow user, 
by a system setting.  The passwords required are dynamically created by Impact, in a two-part 
process.  When an Escrow user tries to overdraw a file, they will be warned that a password is 
required, and are they sure they wish to continue, and will offer the user a seed number  for the 
password generator.  If they do need to overdraw the file, they will call an Accounting user, who 
will ask for the seed  number , which they will enter into this module.  A password will be 
generated, which will be given back to the Escrow user.  They will enter the password and they 
will then be permitted to continue with their transaction that will overdraw their file. 

 

There are two items under this menu option: 

 Password Generator 

 Print Overdraft Authorization Log 

 

When Accounting gets the call for a password, from 
Escrow, they must determine if the caller should be 
permitted to overdraw the file.  Each company will have 
its own policies and procedures for this determination.  
Assuming they determine the Escrow caller may 
overdraw the file, they will open the Password 
Generator  and get the screen on the right.  They will 
enter the seed  provided by Escrow and hit the TAB  key.  
The password will be presented.  They will give the 
password to the Escrow caller, who will use the 
password.  Click on OK to close the screen. 
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The Print Overdraft Authorization Log function generates a report of all password requests and 
approvals given.  The layout looks like this: 

 

 

The file involved, the date of the request, the user login that made the request, and the date and 
time and user login that provided the password are all presented.  As you can see, protection of 
user logins is very important, to prevent someone from using your login to authorize an overdraft. 

 

Wire Out Audit Report 

The Wire Out Audit Report  will only be a menu selection if Dual Authorizations for Wire Outs  
is enabled within the setup options.  Dual Authorization for Wire Outs  is only available if the 
wire out feature, through which Accounting confirms a wire out is enabled.   You may generate a 
wire out audit report on all files for a date range, or a specific escrow file for a date range. 

 
This Wire Out Audit Report  shows the tracking of a wire out from the time it was entered into 
Impact, approved by an authorized user, and sent by the Accounting user. 
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Print HUD 

Sometimes the Accounting user will compare the income file to what was entered on the HUD. 
Having the ability to print the HUD from within the Accounting module eliminates Accounting from 
having to sign into the Escrow module to view or print a HUD.  The same print feature is located 
in the Escrow module under  Documents.  The user needs to enter the escrow number, then click 
on the HUD selection radio button for the desired format, a combined HUD, a buyer’s only HUD 
or a seller’s only HUD.  The print options area has a drop down menu, to select a label that will 
appear on page one of the HUD.  
 
The option to print with a certification page will provide the user with a page where the buyers and 
sellers sign and approve the HUD as being an accurate representation of the transaction they are 
parties to. 
 
The user may also select whether they would like a letter size or legal size HUD printout.  The 
letter size document removes lines that do not have entries on them.  The letter size is helpful for 
faxing to someone who is using letter size paper in their fax machine. 

 

Print Final Disbursement Report 

The Print Final Disbursement Report  is a printout showing all funds receipted and disbursed 
along with receipt numbers, check numbers, and payees.  This report is also located within the 
Escrow module under the Disburse  menu.  Impact has two styles available for the Final  
Disbursement Report .  Depending on your company’s selection you may have a short Final 
Disbursement Report  that shows receipts and checks with just the payee name, check 
number issued and dollar amounts .  The long form differs by showing the payee name, 
address, and breakdown of the check . 
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Naf Menu 

The Name and Address File (Naf) or customer list is a very important tool in Impact.  Depending 
on the company’s configuration, there may be one centralized Naf or a different Naf for each 
escrow branch.  The Name and Address File (Naf) is displayed in a tiered manner: Company – 
Branch - Individual.  This will provide a better way to show the relationship between an individual 
and where he/she works. 

Add and Modify 

Maintenance of the Naf is done through this menu, if you have authorization to change the Naf.  
The Naf can be centralized or branch-specific, depending on system configuration.  The Naf can 
also be limited as to whom is permitted to edit it. 
 
In the Search for Name starting with  field, type in a search term of at least two characters, and 
Impact will automatically display the results, or you may use the percent sign (%) as a wildcard 
character. 
 
You may narrow your search by selecting one of the 8 Search Options  and/or search 
parameters, by Name, ID, county, or state.  If your company is using the tiered effect, you may 
check the Expand box and see any relationships to the company name that have been added. 
 
NOTE: If you are not authorized to edit the Naf then the New, Modify  and Delete  buttons will be 
deactivated (dimmed out). 

 
In the search results display, the company entries are bolded, branch entries are not bolded and 
individuals’ entries are italicized for enhanced readability. 
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New 

You can add a new Naf entry by clicking on the New button.  Impact will display a prompt asking 
if you would like to: add a new Company, add a branch under the Company, add an individual 
user under the Branch or add an individual user under the Company.  Based on your selection 
you will be presented with an empty form on the right side of the NAF screen.  Complete the form 
with as much information as is available.  Click on Save to accept your entries, or on Cancel  to 
quit without saving.   
 
The entries are tiered by Company – Branch – Individual/User levels in the NAF.  In the display 
below, the initial entry shows only a “Company” listing. 
 

 
 
By clicking on the New button the New NAF Entry  form is opened. 
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In the updated screen below, the left side of the screen shows the completed set of data for 
the Company with a branch, branch users, company users and a second company listed. 
 
 

 
 

Modify 

 
To make changes to a Naf item, highlight a name and then click on Modify  to open the Modify 
Name and Address  screen.   
 
Select one of the Search Options , then modify fields as needed on the rest of the screen.  
Depending on system configuration, an automatic Id No  can be assigned to each customer.  The 
automatic ID No‘s are useful to coordinate customer numbering with an outside accounting 
system.  The Comments  area of the screen can be used for mobile phone numbers, pagers, etc. 
 
At the bottom of the screen the Naf has fields available for a Bank Name , Account Number  and 
Routing Number .  This is useful information to have filled out before wiring money.  The bank 
Routing Number  must be a valid receiving bank ABA number or Impact will not accept the 
routing number.  While bank routing numbers are downloaded from the Federal Reserve website 
and updated by the system administrator periodically, in order to validate ABA #’s on wire entries, 
the entries in the NAF are NOT updated by the ABA downloads. 
 
The NAF function allows the user to flag a NAF record as inactive.  Setting a Company level 
record as inactive, sets all related parties as inactive.  Setting a single related party as inactive 
will dim the specific entry and still allow the user to use the Company level record and any other 
records not set as inactive . 
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Click on Cancel  to abort any changes and return to the Name and Address File  screen, or Save 
to save any changes or new entries to the screen.    
 

Delete 

Delete  will delete the entire Naf entry (a dialogue box will ask for confirmation). 

Print 

A name and address listing can be generated for any or all of the Naf categories.  By default, in 
the Print Options  area of the screen, all the fields are checked. Place the cursor on a check box, 
and uncheck any categories that should not be printed. 
 
Click on OK to print, or Cancel  to abort any changes and 
return to the Impact desktop. 
 
Optionally, click on OK, then on Preview . From this preview 
screen, these print results can be exported to a file (click on 
the envelope-with-arrow icon on the top left corner of the 
screen), for example a .CSV file, and used in Microsoft Word 
via the Tools  > Letters and Mailings  > Mail Merge  
function, for seasonal greeting cards, mass mailing, etc.  
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About Menu 

To determine the Impact Accounting module version and build number, select this menu option.  
Please have this version number information available when calling the Help Desk for assistance. 
 
 
 
 

 
 
 
NOTE: The build number, in parentheses after the version number, for each Impact/SQL module 
may be different from another Impact/SQL module, for example, the Escrow module may not be 
the same build as the Title Module. 
 

Version and Build 
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Appendix A - Troubleshooting 

USA Digital Solutions (DSI) Support personnel may ask that you make a screen shot so that you 
can e-mail Support a “picture” of the screen as it appears when the error occurs. 
 
To create this screen shot and save it for the Support personnel: 
 
Press the PRINT SCREEN key on the keyboard, which is usually located on the top row of the 
keyboard, and is usually the third key from the right. 
At bottom left of your windows screen, click on the Start  button.  From the menu, select New 
Office Document . 
After the Microsoft Word application starts, go to the top left of the screen with the cursor and 
from the menu select File  > New. 
As soon as Microsoft Word opens a new document, go to the top left of the screen with the cursor 
and from the menu select Edit  > Paste . 
After the screen shot is pasted into the document, go to the top left of the screen with the cursor 
and from the menu select File  > Save.  Save this document in a location from where you can 
send it as an e-mail attachment (navigate to wherever you put non-Impact Microsoft Word 
documents).  You will have to remember the path and the document name in order to locate this 
document later. 
After the document is saved, go to the top left of the screen with the cursor and from the menu 
select File  > Close  to close Word. 
Return to your Impact session and finish the current process. 
Now e-mail the saved document as an attachment, via your normal e-mail routine, to the email 
address provided by DSI Support personnel.  DSI Support personnel can be reached at (602) 
866-8199 extension 2. 
 


